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ECT is a complex medical procedure. Its proper and safe conduct requires a staff of 
professionals who are experienced with the procedures and familiar with the 
medical literature concerning the risks, benefits, complications, and methods of 

CT. This literature includes the major textbooks of ECT and of nsvchiatrv the 
Journal of ECT and publications about ECT that have appeared" to Íhe ma 

journals of psychiatry. As with other aspects of medical practice, knowledge about 
ECT continues to change and clinicians are responsible for maintaining awareness 
of these changes from these publications and other sources.

Reports in the medical literature describe the incidence of death associated with 

cardiac8 about] in ’ Other serious adverse events have occurred, including cardiac arrhythmia, myocardial infarction, acute hypertension, aspiration 
pneumonia, hypoxia, respiratory obstruction such as laryngospasm, puhnona™ 
embolism., prolonged apnea, tardive seizure, non-convulsive status epsepanans, 
partial relief oi depressive anergia enabling suicidal behavior, and falls. Concurrent 
administration of antipsychotic (neuroleptic) medication may increase the risks of 
adverse cardiac pulmonary, and neurological events, and falls. Concurrent 
administration of stimulants may increase the risks of cardiac and neurological 
complications, such as prolonged seizure. 8
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SAFETY INFORMATION

Please read the following important safety requirements before using the 
Thymatron® System IV ECT Instrument.

' CAUTION. Do not subject the Thymatron® System IV to extreme moisture or 
use it after it has been partially or totally immersed in liquid or when a significant 
amount of liquid has been spilled on it. Power the unit off and have it checked by a 
qualified technician before powering it on or using it again.

WARNING: Do not remove the top or bottom covers of the Thymatron® System 
IV. There are no user serviceable parts inside. Any servicing must be performed by 
qualified service personnel.

CAUTION: Only use with the Somatics’ Treatment or Monitoring Cables.

CAUTION: The Treatment and Monitoring Cables are not interchangeable, and 
can not be inserted into the wrong front panel connector. Attempting to insert the 
Treatment Cable into the connector intended for the Monitoring Cable (and vice 
versa) will damage both the connector and the cable.

WARNING: Do not use any cables or lead wires that appear to be damaged.

WARNING: The Thymatron® System IV is defibrillator protected. 1A 
Nevertheless, for safety reasons, all cable connections between the Thymatron® 
System IV ECT Instrument and the patient must be disconnected prior to initiation 
of the defibrillation stimulus.

CAUTION: Do not dispose of your Thymatron® System IV in the general waste. As 
per Diiective 2002/96/EC for the disposal of electrical and electronic equipment 
please contact the manufacturer for instructions.

WARNING: Avoid the risk of accidental shock to medical personnel. Do not 
contact the patient, or any conductive surface touching the patient, unless wearing 
electrically insulated gloves. If holding the patient’s jaw or touching the patient's 
head during the electrical stimulus, make sure to use electrically insulating gloves.

CAUTION: Prior to initiating ECT on a patient with a cochlear implant, healthcare 
professionals should discuss the issue with an otolaryngologist or audiologist and 
review the cochlear implant Instructions for Use.
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The Thymatron® System IV Treatment Cable, Monitoring Cable and lead wires 
can be cleaned by wiping them off with a Germicidal Disposable Cloth. Steel 
stimulus electrodes may be cleaned with soapy water or alcohol. Thymapad® 
electrodes are single use only and must be discarded after the treatment.

The Thymatron® has no special requirements for restricted environment during 
transport or storage, beyond Standard Sub-clause 10.1 criteria.

DISCLAIMER

Please note that nothing in this manual constitutes, or should be construed as, a 
claim by Somatics LLC that confusion, cognitive impairment, or memory loss 
(short-term, long-term, recent, remote, transient, or persistent) can not occur as the 
result of ECT. Many patients experience temporary loss of recent or remote 
memories with ECT, particularly with traditional bilateral ECT. A few patients 
have reported experiencing persisting loss of memories or memory functions after 
ECT. These are subjective symptoms that have not been related to observable 
structural brain changes. Mental and physical illnesses, anesthesia, medications, and 
postponement of treatment each have their own adverse effects, which can be 
substantial.

The 0.3 ms pulsewidth is available as an option at no charge. If the Thymatron® 
System IVhas 0.3 pulsewidth enabled, please change all 0.25 in the manual listing to 
be 0.3.
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SPECIFICATIONS
The Thymatron® System IV is Class 1, Type BF 14/

STIMULUS OUTPUT
Current: 0.9 amps constant current, limited to 450 volts, isolated from line current

Frequency: 10 to 70 Hz, in 10 Hz increments (to 140 Hz in LOW 0.25/0.3 Programs)

Pulsewidth: 0.25 to 1.5 ms, in 0.25 ms increments (0.3 ms is available)

Duration: 0.14 to 7.99 s in increments of equal charge

Maximum output: Standard maximum output across 220 ohms impedance, 504 mC 
(99.8 joules). Output for double dose modes (where available) across 

• 220 ohms impedance: 1008 mC (199.6 joules). Actual (delivered) 
treatment output shown on printed report in mC

RECORDING
4 recording channels: channels 1 & 2, EEG; channel 3, EMG; channel 4, ECG.
8 user selectable gain positions for EEG channels (10, 20, 50, 100, 200, 500, 1,000 
and 2000 pV/cm) and EMG or ECG channels (50, 100, 200, 500, 1000, 2000, 5000 
and 10,000 pV/cm)

REQUIREMENTS 100-130 volts (120 volts) AC, 60 Hz, single phase. 150 VA. 
(220-240 volt, 50/60 Hz, switchable)

STIMULUS GENERATION
Waveform: bipolar, brief pulse, square wave

IMPEDANCE

Static Impedance Test: 0 to 3000 ohms static (+/-100 ohms) at 800 Hz 
(L.E.D. and printed report)

Dynamic Impedance Measure: 0 - 500 ohms (printed report)

SEIZURE MONITORING

Channel specifications:
Maximum gain: EEG, 10 pV/cm; EMG 50 pV/cm; ECG 50 pV/cm
Common mode rejection: 80 dB
Isolation: full, opto-electronic
Printer paper speed: user selectable: 5-50 mm/s

Seizure Quality Measures:

Postictal Suppression Index (EEG): range, 0-100%
Average Seizure Energy Index (EEG)
Maximum Sustained EEG Power and Time to Peak EEG Power
Maximum Sustained EEG Coherence and Time to Peak EEG Coherence
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Duke University EEG Measures
Power Spectral Analysis by Fast Fourier Transform, (FFT)
Peak Heart Rate: beats/min
Computer Seizure Endpoint Estimates by EEG and EMG

EEG FREQUENCY MEASURES

95% Spectral Edge Frequency
Median Frequency 
Relative Delta Power

DIMENSIONS
Weight: 22 lb
Height: 
Width: 
Depth:

5.5”
17.5”
13.0”

INDICATIONS FOR USE

We recommend that doctors planning to use the Thymatron® System IV read and 
follow the recommendations of the Task Force Report of the American Psychiatric 
Association as set forth in “The Practice of Electroconvulsive Therapy” (American 
Psychiatric Association, 2001). To briefly summarize these recommendations here, 
the Thymatron® System IV is intended to be used to administer electroconvulsive 
therapy (ECT) to patients suffering from mental disorders in which a rapid, 
definitive response is desired. ECT is most often indicated in patients who have not 
responded to adequate courses of appropriate pharmacotherapies, but is also 
indicated as the primary treatment for patients in whom a rapid or high probability 
of response is desired (as when they are severely medically ill or in danger of 
harming themselves) or who are known by their treatment history to respond only 
to ECT, or who have expressed a valid preference for ECT over alternate therapies.

PATIENT SELECTION CRITERIA

The principal diagnostic indications for ECT as outlined in the Task Force Report 
of the American Psychiatric Association (APA, 2001) are Major Depression (all 
types). Mania, and Schizophrenia (characterized by abrupt or recent onset, 
catatonic features, psychotic symptoms, or a history of ECT response).

CONTRAINDICATIONS AND WARNINGS

The Task Force Report of the American Psychiatric Association (APA, 2001) 
recognizes no absolute medical contraindication to ECT. It does warn about 
specific conditions that may be associated with substantially increased risk, 
including unstable or severe cardiovascular conditions (recent myocardial 
infarction, unstable angina, poorly-compensated congestive heart failure, severe
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valvular cardiac disease), vascular aneurysms susceptible to rupture with increased 
blood pressure, increased intracranial pressure, recent cerebral infarction, severe 
chronic obstructive pulmonary disease, asthma, pneumonia and anesthesia risk level 
ASA 4 or 5.

INSTALLATION

Unpack the instrument, open the black case, and place the instrument on a firm, flat 
surface such as a hospital cart. Check the instrument for any damage, and make 
sure the rear panel voltage designation matches that of the electrical outlet to be 
used. Determine that all manuals and items are present. If required, have the Safety 
Check performed as described in the Service Manual, Section 2.

Connect the power cable to the rear of the unit. Power the unit on and observe that 
the POWER switch light comes on, the self test runs successfully and “BASELINE” 
is displayed. Load a pad of thermal paper as per the instructions inside the paper 
door (see page 12). Turn the power switch off and on again to verify that the 
recorder prints the date and software version. This completes the installation.

OPERATING INSTRUCTIONS

The new Thymatron® System IV features two front panel controls for display and 
selection of all treatment choices: the PERCENT ENERGY stimulus dose dial and 
the FLEXDIAL™ function and option selector.

In addition, you will see a POWER switch (power on/off), an IMPEDANCE TEST 
button, a ST AR I /STOP button (to manually control the 4-channel printer), a 
IREAT button (to deliver the treatment stimulus), two alphanumeric L.E.D.s (the 
left one with 8 characters, the right one with 4 characters), and 5 individual dot 
L.E.D.s (to indicate activation of the FlexDial selection mode, activation of the 
Safety Monitor alarm, activation of monitoring ECG in channel 4, and whether the 
preset program or a user set selection is in effect).

POWER ON/OFF

Be sure the power cable is plugged into a grounded, 3-prong hospital-grade socket. 
Press the top half of the front-panel POWER switch (labeled “I”) to turn the unit 
on; press the bottom half of the POWER switch (labeled “0”) to turn the unit off.

SELF TEST

The Thymatron® System IV automatically tests the integrity of all circuits. When 
the unit is powered on, a flashing nonsense symbol appears for several seconds in 
the 8-character L.E.D., followed by the flashing message “SELFTEST” for a few 
seconds, then a self-test confirmation report is printed and the words “NO BASE” . 
appear, indicating that baseline EEG collection still has yet to be accomplished. (See 
IMPEDANCE TEST procedure section for baseline EEG collection.)
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The printed SELF TEST confirmation report will appear on the paper strip as:

Thymatron® System IV S/N [serial number here]

Date - Time S-IV version [software version] I [the number 60 or 50 Hz]

The Thymatron® S/N line can be replaced with the hospital’s name (see page 30).

PERCENT ENERGY DIAL

The PERCENT ENERGY dial is used to select the treatment stimulus dose. This 
dial has three functions that are displayed in the 4 character L.E.D. above the dial.

1. Rotating the dial displays the PERCENT ENERGY settings for each stimulus 
dose, followed by a brief display of the corresponding stimulus charge in mC.

2. Pressing the dial displays the stimulus program currently in effect.
3. Pressing, holding in and then rotating the dial enables the operator to rapidly 

change stimulus programs without using the FlexDial™.

To display the corresponding charge in mC again, rotate the PERCENT ENERGY dial 
in either direction and then back again to the desired setting.

LIGHT-EMITTING FUNCTION DISPLAYS

The Thymatron® System IV front panel has two alphanumeric L.E.D.s (the left one, 
with 8 characters, and the right one with 4 characters), plus 5 individual dot L.E.D.s

8-character L.E.D. Located above the IMPEDANCE TEST button

1. It displays the message “SELFTEST” immediately after the unit is powered on.
2. It displays the message “NO BASE” following completion of the self-test 

procedure and before baseline EEG collection has been initiated.
3. It displays the message “TESTING” for 1 second when the IMPEDANCE TEST 

button is pressed.
4. It then displays the static impedance value in ohms, and maintains it until the 

button is released.
5. It displays the message “BASELINE” from the time the IMPEDANCE TEST 

button is released until baseline EEG is obtained, about 6-10 seconds.
6. It displays the message “READY” when baseline EEG collection has been 

successfully accomplished.
7. After the “TREAT” button is pressed and released, it shows the time elapsed in 

seconds since the end of the treatment stimulus.
8. It displays the flashing message “REPORT” when the START/STOP button is 

pressed to generate and print the end-of-treatment report.
9. It displays the designations and values of all FlexDiaFM functions and options 

during their selection.
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4-character L.E.D. Located above the PERCENT ENERGY dial

1. It displays the different PERCENT ENERGY values as the dial is rotated.
2. It then briefly displays the mC of charge corresponding to each PERCENT 

ENERGY dial setting.
3. It displays the stimulus program in effect when the dial is pressed.
4. It displays the options for the stimulus programs when the dial is pressed, held in 

and rotated. Releasing the dial, selects that program.

Dot L.E.D.s Located on the front panel

1. The L.E.D. labeled “FLEXDIAL” flashes when the FlexDial™ is activated.
2. The L.E.D. labeled “SAFETY MONITOR ACTIVATED” flashes when the 

Safety Monitor has been activated.
3. The L.E.D. labeled “PRESET” lights when the LOW 0.5program is in effect.
4. The L.E.D. labeled “USER SET” lights when a user set selection is in effect.
5. The L.E.D. directly above the “EEG/ECG/EMG” monitoring jack stays lit 

unless channel 4 is being used to monitor the patient’s ECG. When channel 4 is 
connected, the light goes off.

SAFETY MONITOR CIRCUIT ALARM TEST

The Thymatron® System IV has a Safety Monitor Circuit test button on the back 
panel labeled “ALARM TEST”. This test can be performed annually or as hospital 
regulations require. The Safety Monitor Circuit test is performed as follows:

1. Power on the Thymatron® System IV and connect the ECT stimulus cable.
2. Rotate the PERCENT ENERGY dial to any setting.
3. Connect the ECT stimulus cable banana plugs to a 200 ohm, 10 watt load 

resistor (or insert these banana plugs into the designated jacks of the 
ECTOBRAIN™ II testing device).

4. First press and hold down the rear panel “ALARM TEST” button. Next, press 
and hold the “TREAT” button, and then release the “ALARM TEST” button.

5. Continue pressing the “TREAT” button while the Thymatron® System IV goes 
through the full cycle of stimulus warning signal and stimulus indicator tones, 
then release the “TREAT” button.

At the end of the stimulus indicator tones the “SAFETY MONITOR ACTIVATED” 
dot L.E.D. will go on and a high-pitched, continuous signal tone will sound until the 
unit is powered off. This shows the alarm signal is operating correctly. If the indicator 
light and alarm signal tone do not occur, do not use the unit to treat patients until it 
has been examined and cleared by authorized biomedical personnel.
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FRONT PANEL JACKS

ECT Stimulus Jack
This 2-pin jack labeled “ECT” is located below and to the left of the IMPEDANCE 
TEST button. It accepts the plug from the ECT stimulus cable.

EEG/ECG/EMG Monitoring Jack
This 9-pin jack labeled “EEG/ECG/EMG” is located below and to the right of the 
IMPEDANCE TEST button. It accepts the plug from the EEG/ECG/EMG 
monitoring cable.

A CAUTION: It is impossible to insert the plug from the stimulus cable into the 
monitoring jack and vice versa. Forcing the wrong cable in will break the connector.

FLEXDIAL™ OPERATION

The FlexDiaP^ has 18 different user-selectable functions, plus the ability to change 
EEG gain yvhile the printer is running. All functions and options can be displayed, 
then selected with alternating rotations and presses of the FlexDiaP^, according to 
the following general principles:

1. Rotating the FlexDiaF^ in either direction provides a sequential display of all 
functions or options in that particular level. You can reach any other 
function or option in the same level by rotating the dial.

2. Pressing the FlexDiaFM selects the function or option displayed in the 8- 
character L.E.D. and advances to the next choice.

3. Pressing, holding in, and rotating the FlexDiaF^1 while the printer is running 
allows the operator to rapidly change the gain in all EEG channels.

TO ENTER FLEXDIAL™ MODE:

With power on, press the FlexDiaFM. The most recently selected function in the 
“SETTING” level will appear in the 8-character L.E.D. The FlexDiaFM dot L.E.D. 
will flash to indicate that you are now in the FlexDiaPM mode.

These function headings (e.g., “SETTING”, “PROGRAMS”, “INDEXES”, etc.) do 
not change a particular setting, but are the FlexDiaF^ locations from which to 
select a range of related options. For example, selecting the “PROGRAMS” 
function, leads you to the options of: the traditional DGxprogram, three Low Charge 
Rate programs, the Intermittent (Pulse Volley) stimulus mode, the double dose 
program (where available) and the USER mode.

NOTE: Pressing the FlexDiaFM will select the above program being displayed. Once a 
function or option is selected with the FlexDiaFM it remains in effect until changed, 
even when the unit is powered off.
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TO EXIT FLEXDIAL™ MODE:

There are two ways to exit FlexDial™ mode: Pressing the START/STOP button of 
the printer or pressing the IMPEDANCE TEST button. The FlexDiaF^ dot L.E.D. 
will stop flashing upon exit.

1. Pressing the START/STOP button locks in the selection, generates a printed 
report of the 13 FlexDiaF^1 selections in effect and exits the FlexDiaFM mode.

2. Pressing the IMPEDANCE TEST button locks in the selections and exits the 
FlexDiaFM mode without generating a printed report.

FLEXDIAL™ MODEL PROCEDURE

For the remainder of this manual, selection of FlexDiaF^1 functions and options will 
be shown by the following shorthand notation with the explanation listed below:

FLEXDIAL™ 9 [function] 9 [options]

1. Press the FlexDiaPM to display the most recently adjusted FlexDiaF^1 function.
2. Rotate the FlexDiaPM in either direction to display the desired function.
3. Press the FlexDiaFM to flash-display the option in effect for that function.
4. Rotate the FlexDial™ to flash-display the other options.
5. Press the FlexDial™ to select the desired option and advance to the next option 

(if there is one) or to return to FlexDiaFM function level.
6. Press the IMPEDANCE TEST or START/STOP button to lock in the option 

and to exit the FlexDiaF^ mode.

Example'.

FLEXDIAL™ 9 CH 3-4 9 EMG-ECG, EEG-EEG means

1. Press the FlexDiaFM to display the most recently-adjusted FlexDiaF^1 function.
2. Rotate the FlexDiaPM in either direction to display the “CH 3-4” function.
3. Press the FlexDial™ to flash-display the option in effect.
4. Rotate the FlexDiaF^ to flash-display the options, EMG-ECG or EEG-EEG.
5. Press the F!exDiaFM to select the desired option and return to FlexDiaF^ 

function level, “CH 3-4”.
6. Press the IMPEDANCE TEST or START/STOP button to lock in the option 

and to exit the FlexDiaFM mode.

11
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FLEXDIAL™ FUNCTIONS AND WHAT THEY CONTROL

FLEXDIAL™
FUNCTION SELECTS THESE OPTIONS

SETTING 
CHANN. 1 
CHANN. 2 
CHANN. 3 
CHANN. 4 
FREQUENC 
P-WIDTH 
PROGRAMS 
SAVE USR 
CH 3-4 
ENDPOINT

Resets to factory specifications, loads up to 8 user set selections
Channel 1 gain and position settings
Channel 2 gain and position settings
Channel 3 gain and position settings
Channel 4 gain and position settings
Stimulus frequency (10 Hz - 70 Hz in 7 steps)
Stimulus pulsewidth (0.25 ms — 1.5 ms in 6 steps) (0.3 ms available)
Selects from 7 factory pre-programmed or user stimulus programs
Stores up to 8 user set selections
Enables channels 3-4 to monitor either EMG-ECG or EEG-EEG
Enables endpoint detection of EEG, EMG, HR measures, prolonged 
seizure alert signal and Baseline Retention, BLV

INDEXES 
EEG FREQ 
PRINTOUT 
UPLOAD 
DATA OUT 
DATA IN

Enables seizure quality measures
Selects one of three EEG measures
Enables printer and FFT printout, sets paper speed
Enables sending treatment data to a PC automatically 
Reprints treatment just given; sends treatment data to PC 
Accepts hospital’s name from PC for the printed report; 
Accepts treatment data for re-printing treatment record

CLOCK Sets month, day, year, hour, and minute on printed report

Additionally, pressing, holding in, and rotating the FlexDial™ while the thermal 
printer is running will change the gain in all EEG monitoring channels.

If the 0.3 ms pulsewidth is enabled, there are no 0.25 ms pulsewidth settings, All other 
pulsewidths are available.

12
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PAPER LOADING INSTRUCTIONS

The Thymatron® System IV printer paper holder is located just below Somatics’ 
logo on the right side of the front panel. Press the arrow on the top cover release bar 
to open the printer cover door. Remove the cardboard sheets and place the fan 
folded paper pad inside. Make sure the black squares are on the right side and the 
warning strips on the bottom of the pad. Fold over the top sheet and feed these 
double sheets into the printer, just below the roller. The printer will automatically 
advance the paper to the correct point and stop. Press and release the START/STOP 
button to feed a sheet of paper.

STIMULUS CABLE CONNECTION

Connect the plug of the black ECT stimulus cable into the jack labeled “ECT”, 
located on the lower left front panel.

MONITORING CABLE CONNECTION

Connect the plug of the gray EEG/ECG/EMG monitoring cable into the jack labeled 
“EEG/ECG/EMG”, located on the lower left front panel, just to the right of symbol 
of the human figure inside a box.

CAUTION: The Treatment and Monitoring Cables are not interchangeable. They 
can not be inserted into the wrong connector. However, forcing them into the wrong 
place will damage the connectors or the cables.

LEAD-WIRE CONNECTIONS

The Thymatron® System IV is shipped with 9 standard length (24 inch) lead-wires: 
4 red, 4 black, and 1 green. Also included are 2 extra length (60 inch) brown lead- 
wires for recording EMG from the leg, if desired. Any combination of channels 
(from 1 to 4) can be used to monitor the patient. Not all channels need to be used. 
However, channel 1 must be used to obtain baseline EEG and seizure endpoints.

Plug the red lead-wires into the receptacles for channels 1, 2, 3 & 4 indicated by red 
dots at the flared end of the gray monitoring cable, and plug the black lead-wires 
into the corresponding receptacles for channels 1, 2, 3 & 4 indicated by black dots. 
Plug the green lead-wire into the green receptacle marked ^Iso Gn(P\ If monitoring 
EMG from the leg, insert the brown lead-wires into the channel 3 receptacles (in 
any order) instead of the red and black lead-wires. The ordinary lifespan of a lead- 
wire is one year. With infrequent use some will last longer. Replacement lead-wires 
are available separately from the entire monitoring cable.

14
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SEIZURE MONITORING CONSIDERATIONS

Somatics’ stick-on, snap monitoring electrodes, [Cat. # EEDS] are ideal for EEG, 
ECG and EMG monitoring. Their size and rectangular shape facilitate fronto- 
mastoid and bifrontal application without interfering with the stimulus electrodes. 
Prepare the skin sites by vigorously rubbing with an alcohol swab and w iping dry.

Polarity of recording electrodes can be important for EEG recording, so carefully 
follow the instructions below. Each recording channel takes one negative and one 
positive lead-wire, designated as black and red, respectively. On the monitoring 
cable, the holes facing the label are designated red (positive), and those on the side 
opposite from the label are designated black (negative). The 2 long lead-wires for 
recording EMG from the foot are color-coded brown for quick recognition since 
polarity is not an issue with either EMG recording.

The green ground lead-wire always plugs into the green-coded socket labeled ISO- 
GRND; only one ground is required no matter how many channels you monitor.

Monitoring Electrode Placement:

We recommend two-channel EEG monitoring because it takes full advantage of all 
the special and unique monitoring features of the Thymatron® System IV, and with 
the splitter included, requires only one more lead-wire than single-channel EEG 
monitoring. If you do choose single-channel EEG monitoring we recommend a left 
fronto-mastoid placement because it can demonstrate seizure generalization to the 
left hemisphere when giving right unilateral ECT.

Regardless of how many channels you choose to monitor, Channel 1 must always be 
used for EEG in order to obtain a baseline EEG sample for the determination of the 
EEG endpoint and the EEG indexes, channel 3 must always be used to monitor 
EMG, channel 4 must always be used to monitor ECG, and the green ISO-GRND 
channel must always be used for the ground.

The preferred 4-channel monitoring configuration using the splitter (EEG in channels 
1 & 2, EMG in channel 3, and ECG in channel 4)

EEG: fronto-mastoid EEG electrode placements are recommended. Place a 
monitoring electrode in the center of the forehead, another electrode over the left 
mastoid bone, and a third electrode over the right mastoid bone. Plug the two 
narrow ends of the splitter into the black positions for channel 1 and 2. Then 
connect a black lead-wire to the channel 1 position on the splitter, leaving the 
channel 2 position on the splitter empty. Connect this black lead-wire to the top 
front forehead monitoring electrode. Connect two red lead-wires to channel 1 & 2 
red positions and clip the ends to the corresponding mastoid electrodes. Apply a 
monitoring electrode to either shoulder as a ground and connect it to the green lead- 
wire.
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ECG: The great advantage of monitoring ECG with the Thymatron® System IV 
rather than (or in addition to) equipment provided by the anesthetist is that you get 
a permanent record of the heart rate printed every three seconds on the recording 
strip, plus an end-of-treatment printout of the baseline and peak heart rates, to help 
you assess the efficacy of the seizure just given.

Apply two monitoring electrodes over the anterior chest above and below the heart, 
spaced about 8” apart. Connect the channel 4 red and black lead-wires to the 
precordial electrodes in any order of polarity, and insert in the channel 4 holes.

EMG: The purpose of monitoring EMG is to provide an automated and highly 
accurate estimate of the motor seizure duration. Apply two monitoring electrodes 
spaced about 3” apart to a limb that has been cuffed to prevent the effects of the 
muscle-relaxant drug. Connect the channel 3 red and black lead-wires in any order 
of polarity to monitor from the patient’s arm and plug into the channel 3 holes. (Use 
the brown 60 inch lead-w ires to monitor from the patient’s foot, as illustrated.)

A 3-channel monitoring setup (EEG in channel 1, EMG in channel 3, and ECG in 
channel 4)

For the preferred left fronto-mastoid EEG configuration, place one monitoring 
electrode above the left eyebrow and the other electrode over the left mastoid bone. 
Connect the channel 1 lead-wires to the monitoring electrodes in any order of 
polarity (no splitter is used), and connect the ECG and EMG electrodes, ground 
electrode, and lead-w'ires as described above.

For 3 or 4-channel EEG monitoring (primarily used for research) use the electrode 
placements of your choice, remembering to keep the polarity (relationship of red 
and black lead-wires) consistent for corresponding channels on each side of the 
head. If you connect the red and black lead-wires to frontal and temporal 
monitoring electrodes, respectively, on the left side of the head, be sure to maintain 
the same polarity relationship when connecting the corresponding pair of frontal 
and temporal electrodes on the right side of the head. Apply a monitoring electrode 
to either shoulder as a ground and connect it to the green lead-wire clip.

CHANNELS 3 & 4 SELECTION

EEG is always monitored from channels 1 & 2 and they are not user selectable. 
Channels 3 & 4 can monitor either EMG and ECG or two more channels of EEG. 
To select the monitoring options for channels 3 & 4, follow the procedure below:

FlexDial ^ CH 3-4 •> EMG-ECG; EEG-EEG
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STIMULUS ELECTRODE APPLICATION

Apply the Thymapad™ adherent stimulus electrodes [Cat. # EPAD] supplied with 
the Thymatron® System IV, according to the directions, “Use of Thymapad™ 
Disposable ECT Stimulus Electrodes”. Clean the patient’s skin sites by rubbing 
vigorously with a saline moistened swab and pat dry. Do not use solvents (e.g., 
alcohol) with Thymapad stimulus electrodes. Spread 1-2 drops of Pre-Tac solution 
over the site and rub into the skin with a fingertip until dry. Remove a Thymapad™ 
from its wrapper, peel it from the plastic backing, and apply it firmly to the bare 
skin.

Insert the banana plug from the ECT stimulus cable into the plastic receptacle at 
the end of each Thymapad™ wire, until the entire conducting surface of each 
banana plug is covered and no metal shows. Press firmly once more on each 
Thymapad™ to ensure that it is properly applied and then test impedance.

For conventional bitemporal stimulus electrode placement, clean the skin sites over 
the temples as above. Remove a Thymapad™ from its wrapper and apply it firmly 
to the bare skin of the temple. Apply a second Thymapad™ to the other temple.

For bifrontal placement, place the center of each Thymapad™ 5 cm above the 
lateral angle of each orbit, about 14-15 cm apart. Before peeling the Thymapad™ 
from the backing, bend it to match the shape of the skull at each electrode site.

For Swartz’ left-anterior right-temporal (LART) placement, place the left-sided 
Thymapad™ above the left eye, with its lateral edge bordering the bony ridge 
between the forehead and the temple. Before peeling the left Thymapad™ from its 
backing, bend it to match the forehead’s curve. Place the right frontotemporal 
electrode exactly as described above for bitemporal ECT.

For right unilateral stimulus electrode placement, the d’Elia placement is 
recommended. Clean and dry the skin over the patient’s right temple as above. 
Remove a Thymapad™ from its wrapper, peel it from its plastic backing, and apply 
it firmly to the bare skin at the right temple. Part the hair on the right side of the 
head near the vertex and moisten the scalp thoroughly with a saline-soaked gauze 
pad or saline solution spray. Patients with dense, wiry hair may require full saline 
saturation of the hair and scalp area directly under the electrode. Apply a 
Thymapad™ to the site, holding it firmly in place with the special foam handle 
applicator supplied. (If the patient is bald at the near-vertex site, the upper 
Thymapad™ can be applied directly to the bare scalp after cleaning and drying as 
described above.)

17

CHI000018
Pl. 117



IMPEDANCE TEST (FOR STATIC IMPEDANCE)

Be sure the front panel POWER button is on, the ECT stimulus cable connected to 
the front panel and both stimulus electrodes are firmly applied. Press the front 
panel IMPEDANCE TEST button and observe the static impedance displayed in 
ohms, in the 8-digit L.E.D. Repeatedly checking impedance does not prevent 
ongoing monitoring or affect baseline EEG collection.

CAUTION: DO NOT PRESS THE “TREAT” BUTTON WHEN 
TESTING THE IMPEDANCE

The static impedance test checks the quality of the skin-to-electrode contact. With 
the Thymatron® System IV, the static impedance should be greater than 100 ohms 
and less than 3000 ohms before the treatment stimulus dose is administered. A static 
impedance reading of less than 100 ohms suggests a short circuit, probably in the 
stimulus cable. An impedance reading of 3000 ohms or more appears as the flashing 
number 3000; if this occurs the impedance should be reduced by the following steps:

a) Try pressing firmly on each Thymapad™ again while testing the impedance. 
This is especially important for the vertex electrode with unilateral ECT, which 
should be pressed vigorously in place with the foam handle applicator provided. 
Also for unilateral ECT, make sure that the hair and scalp under the vertex 
stimulus electrode are thoroughly moistened with a saline-soaked pad.

b) If necessary, remove the Thymapad™, pass it under running water, shake off 
the excess water, wait a few minutes and then reapply the Thymapad™ by 
pressing it firmly into place.

c) Check to make sure the electrodes have not slipped or twisted.
d) Reposition the stimulus electrodes to minimize the amount of hair underneath. 
e) Increase pressure on the stimulus electrode by pressing harder with the foam 

handle applicator.
f) Gently rub the skin under the stimulus electrodes with a fine emery board or 

Skin Prep tape (3-M) to remove the top layer of dead cells and sebum. Reapply 
the stimulus electrodes exactly as before.

A common reason for high impedance is that one or more steps were omitted from 
skin site preparation. Please be sure to follow each instruction step when using 
Thymapad™ stimulus electrodes.

During cold weather skin thickens and hardens, causing the static impedance to 
rise. Also, some patients have high readings despite all procedures. Try applying 
skin lotion to the electrode sites between treatments and shortly after waiting on 
ECT days. 5

If the static impedance reading remains >3000 ohms after trying the above 
procedures, try replacing each Thymapad™, the lead-wires or the stimulus cable, 
in that order.
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BASELINE EEG COLLECTION

Prior to collecting a baseline EEG, be sure the automatic EEG endpoint detection 
feature of the Thymatron® System IV is enabled; the EEG monitoring electrodes 
are properly applied to the patient; the monitoring cable with attached lead-wires is 
connected to the front panel; and the lead-wires are clipped to the monitoring 
electrodes.

When the IMPEDANCE TEST button is pressed and held, the word “TESTING”, 
will briefly appear in the 8-digit L.E.D. Then a number ranging from 0 to >3000 
ohm, representing the static impedance, will appear. When the IMPEDANCE TEST 
button is released, the number is replaced by the message “BASELINE”. The 
“BASELINE” message indicates that baseline EEG collection is in progress. When 
baseline EEG collection has been accomplished, the word “READY” will appear in 
the L.E.D. It normally takes about 6-10 seconds for “READY” to appear.

However, moving the patient’s head, touching or moving the monitoring electrodes, 
lead-wires, or monitoring cable during baseline EEG collection will prolong the 
process by introducing EEG artifact. The less the patient and monitoring connections 
are moved or touched during baseline EEG collection, the sooner the “READY” 
message will appear and the patient will be ready to treat. If necessary, stop ventilating 
the patient for the few seconds it takes for the “READY” message to appear. Place the 
lead-wires so that they will not be disturbed by the anesthetist. Each pair of wires can 
be taped together about every 6 inches to minimize movement and artifact.

NOTE: If the “READY” message does not appear before the treatment stimulus dose is 
administered, there will be neither an Ictal Line™ nor EEG endpoint determinations 
or seizure quality measurements because an adequate baseline was not obtained. 
However, the treatment itself will not be affected.

It is not necessary for the Thymapad™ stimulus electrodes to be applied in order to 
obtain a baseline EEG collection. Do not be concerned with an impedance reading 
>3000 ohms when no stimulus electrodes have been applied; baseline EEG collection 
will proceed anyway. Static impedance will be tested after the stimulus electrodes 
have been applied. Repeated pressing of the IMPEDANCE TEST button does not 
interfere with baseline EEG collection.

TIP: It is strongly recommended to initiate baseline EEG collection by pressing the 
IMPEDANCE TEST button on the Thymatron® System IV’s front panel as soon as 
the monitoring electrodes and a ground electrode have been applied., even before 
applying the Thymapad^^ stimulus electrodes (e.g., while the patient is fully awake and 
before anesthesia has been administered). This will provide the longest possible period 
of baseline EEG collection, maximizing the likelihood that a good baseline will be 
collected by the time the treatment stimulus is administered.
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STIMULUS DOSE SELECTION

The Thymatron® System IV is shipped with the LOW 0.5 program enabled. This is 
the recommended choice for the first treatment in all patients for whom there is no 
prior information concerning ECT response or seizure threshold. When desired, the 
FlexDial can be used to select stimulus parameters specifically tailored to the 
patient’s established requirements, or to select from among other factory- or user
set stimulus programs. However, we recommend use of the LOW 0.5 program 
wherever possible, because it provides a broadly effective stimulus that is in the 
physiological range for most patients.

Rotate the PERCENT ENERGY dial to display the available stimulus settings 
(range: 5% to 100% ENERGY in 5% increments). Stop rotating the dial at the 
desired PERCENT ENERGY setting. A 1-second display then appears of the charge 
(mC) that corresponds to the PERCENT ENERGY setting, followed by a return to 
the PERCENT ENERGY number.

NOTE-. The stimulus dose in mC that corresponds to any PERCENT ENERGY 
figure shown in the L.E.D. can be viewed again for 1 second by rotating the 
PERCENT ENERGY dial to either side and then back again.

Because stimulus duration is limited to a maximum of 8 seconds, the higher 
PERCENT ENERGY settings may not be available when the user selects pulsewidth 
or frequency values at the lower end of their ranges. Whenever the PERCENT 
ENERGY setting for a given pulsewidth and frequency would deliver a stimulus 
exceeding 8 seconds, the message ">8 S” will appear.

However, all the factory-programmed preset programs shown in the next paragraph 
will work at all PERCENT ENERGY settings.

Table 1 shows all the standard dosages and stimulus parameters for each 
PERCENT ENERGY setting.

STIMULUS PROGRAMS: FACTORY PROGRAMMED

There are 7 factory set stimulus programs. The “LOW” programs automatically 
adjust the frequency to provide the longest stimulus duration available for a given 
PERCENT ENERGY setting; providing the optimum stimulus for each dose. The 
LOW 0.5 program is the only preset program that will show as “PRESET” on the 
front panel L.E.D. (Both Double Dose Programs are not available in USA or Canada)

DGX Reproduces the standard stimulus of the Thymatron® DGx 
LOWEST Automatically adjusts parameters to provide the lowest charge rate 
LOW 0.25 Fixed 0.25 ms pulsewidth varies frequency to maximize duration
LOW 0.5 Fixed 0.5 ms pulsewidth, varies frequency to maximize duration 
INTERMIT Intermittent pulse-volley stimulus mimics the Siemens Konvulsator 
2X LP Double dose stimulus program using the lowest pulsewidth available*
2X DOSE Double dose stimulus program* (*not available in USA or Canada)
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STIMULUS PROGRAM SELECTION

Any standard (factory-programmed) setting can be selected using the procedure 
listed below. Or, to quickly change programs without the FlexDial, press, hold in 
and rotate the PERCENT ENERGY dial. Releasing it selects the program displayed.

FLEXDIAL™ » PROGRAMS » DGX, LOWEST, LOW 0.25, 
LOW 0.5, INTERMIT, 2X LP, 2X DOSE, USER

Press and hold in the PERCENT ENERGY dial at any time to display the stimulus 
program in effect. Release the dial to return to the PERCENT ENERGY display.

FREQUENCY SELECTION

When a factory-programmed preset stimulus is in effect, frequency is automatically 
adjusted for any given PERCENT ENERGY setting. Selecting a specific frequency 
takes the Thymatron® System IV out of any preset program. To select a specific 
stimulus frequency:

FLEXDIAL™ • FREQUENC • 10, 20, 30, 40, 50, 60, 70 Hz

PULSEWIDTH SELECTION

When a factory-programmed preset stimulus is in effect, the pulsewidth is 
automatically adjusted for any given PERCENT ENERGY setting. Selecting a 
specific pulsewidth takes the Thymatron® System IV out of any preset program. To 
select a specific stimulus pulsewidth:

FLEXDIAL™ • P-WIDTH •> 0.25, 0.5, 0.75,1.0,1.25,1.5 ms

Because stimulus duration is limited to a maximum of 8 seconds, the higher 
PERCENT ENERGY settings will not be available when manually setting the 0.25 
ms pulsewidth, which will provide stimuli only up to the 50% ENERGY. However, 
when the LOW 0.25 program is in effect, stimuli of up to 100% ENERGY can be 
delivered because, for this program only, the frequency can go as high as 140 Hz.

STIMULUS DOSE FOR BILATERAL, BITEMPORAL, BIFRONTAL, LART ECT

For the initial treatment, select the LOW 0.5 program. The PERCENT ENERGY 
dial should be set to approximately one-half the patient’s age (e.g., 25% for a 50 
year-old). If no seizure activity results, the PERCENT ENERGY setting should be 
increased to 100% and the patient re-stimulated within 30-60 seconds to maximize 
the likelihood of obtaining a therapeutically satisfactory seizure at the first 
treatment session.
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Before the next treatment day, the patient’s history and records should be reviewed 
to ensure that dehydration or ingestion of sedative-hypnotic or anticonvulsant 
medications have not contributed to the difficulty in obtaining a good seizure. 
Consideration should be given at the next treatment session to administering a 
stimulus dose at the patient’s age or at maximum charge.

STIMULUS DOSE FOR UNILATERAL ECT

Satisfactory' therapeutic results can be obtained with right unilateral ECT by simply 
setting the PERCENT ENERGY dial to approximate the patient’s age in years (e.g., 
75% for a 72 year-old patient). If a satisfactory seizure is not obtained to the initial 
stimulus with right unilateral ECT, proceed as described in the paragraphs above 
for bilateral ECT.

NOTE: Once a patient obtains a satisfactory seizure with a given PERCENT 
ENERGY stimulus dose with unilateral ECT, we do not recommend administering 
subsequent treatments with progressively lower settings in an attempt to deliver the 
smallest stimulus that will still induce a seizure. This is because minimum stimulus 
dosing has been associated with inadequate therapeutic efficacy for right unilateral 
ECT.

STIMULUS TITRATION PROCEDURE

For those who prefer to set the initial stimulus dose relative to the seizure threshold, 
a simple and practical stimulus titration schedule for unilateral ECT starts with an 
initial setting of 5% ENERGY, followed by re-stimulations at 5% ENERGY 
increments until a seizure occurs, to a maximum of 4 stimulations in a treatment 
session (on average, fewer than three stimuli are required). Once the seizure 
threshold is determined for a specific PERCENT ENERGY setting, the 
recommended dosing level for unilateral ECT is 4-6 times that threshold value (e.g., 
60% to 90% ENERGY for a threshold value of 15% ENERGY).

Because seizure thresholds for bitemporal and bifrontal ECT are higher than those 
for right unilateral ECT, the initial dose for stimulus titration with bitemporal ECT 
should be 10% Energy, with 5% ENERGY increments as described above. The 
subsequent treatments should be administered at doses approximately 2 times this 
threshold (e.g., 40% ENERGY for a patient with 20% ENERGY seizure threshold).

“BENCHMARK” METHOD FOR SETTING AND ADJUSTING STIMULUS

Because neither seizure duration nor seizure threshold are systematically related to 
the clinical efficacy of an ECT treatment, you may wish to consider regulating the 
stimulus dose according to a physiological measurement that has been reported to 
correlate with treatment response (the "target measurement"). Possible target 
measurements include Postictal Suppression Index (PSI), Maximum Sustained 
Power (MSP), or peak heart rate (PEAK HR).
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Unlike stimulus threshold titration, the benchmark method does not require 
administering consecutively increasing sub-threshold stimulus doses until a seizure 
is obtained. Rather, at the first ECT treatment a high enough stimulus dose is given 
to induce an expected vigorous and effective seizure in virtually all patients. The 
value for the benchmark measurement reported in the end-of-treatment report for 
this first ECT treatment is then used as a target for all subsequent treatments.

Selection of the initial stimulus dose for the benchmark method can be made by the 
fixed-dose method or an age-based method. A fixed dose of 75-90% ENERGY 
should be high enough for most patients, regardless of treatment electrode 
placement. Alternatively, the PERCENT ENERGY dial can be set to the patient’s 
age for unilateral ECT, or to 50-75% ENERGY of the patient’s age for the various 
bilateral placements: bitemporal, bifrontal, or LART.

Dosage should be adjusted for subsequent treatments to maintain the selected 
variable (PSI, MSP, peak HR) within about 5% of the established target, keeping in 
mind the often dramatic rise in seizure threshold across a course of treatment. 
Lower target values suggest that the treatment was less than fully effective; this 
might be acceptable for selected patients, but is clearly a matter of medical 
judgment.

Of course, as everywhere in medicine, clinical response is overriding. Patients whose 
EEG or peak heart rate reflect a high seizure quality at lower dosage levels, but who 
are not showing clinical improvement, might benefit from higher doses. Those who 
are enjoying a satisfactory clinical response despite apparently poor quality seizures 
may require no dose adjustment.

DOUBLE DOSE STIMULUS PROGRAM (Not Available in USA or Canada)

The double dose programs automatically vary the pulsewidth and frequency to 
obtain the longest duration possible for any given PERCENT ENERGY dial setting, 
up to 200% ENERGY or 1008 mC. The PERCENT ENERGY settings are in 
increments of 5% up to 100% ENERGY and then in increments of 10% up to 200% 
ENERGY. The double dose programs are selected as follows:

FLEXDIAL™ > PROGRAMS > 2X DOSE
FLEXDIAL™ 9 PROGRAMS 9 2X LP

Table 2 of this manual shows the doses, pulsewidths, and frequencies that 
correspond to the PERCENT ENERGY dial settings for the double dose programs. 
The pulsewidth varies between 0.5 ms and 1.0 ms, while the frequency varies 
between 10 and 140 Hz.
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TREATMENT STIMULUS ADMINISTRATION

Flip up the clear plastic hinged cover over the “TREAT” button. Press and hold the 
button down until the treatment light comes on and then goes off again. While the 
“TREAT” button is held down, the following events will occur:

a. A one second continuous tone warning signal comes on, during which no current 
is delivered. If the impedance is >3000, the warning tone is extended to 3 
seconds. If the “TREAT” button is still pressed, the treatment will be delivered.

b. The “TREAT” button lights up and an intermittent buzzing tone sounds while 
the current is being delivered.

c. The “TREAT” button light and buzzing tone both turn off when the treatment 
stimulus ends. The “TREAT” button can then be released.

d. The Audible EEG1^1 seizure monitor is activated (unless the volume is turned off) 
and the 4-channel printer automatically starts to provide a paper recording. If 
the printer is already running when the treatment stimulus is delivered, the 
printer will stop and automatically resume when the stimulus current ends.

e. The 8-digit L.E.D. on the front panel automatically displays the number of 
seconds elapsed since the end of the stimulus.

NOTE: It is important to continue pressing the “TREAT” button until the light and 
buzzing tone stop. Releasing the button early terminates the stimulus and delivers a 
smaller charge than intended. However, keeping pressure on the “TREAT” button 
after the stimulus ends, will not deliver additional stimulation. When holding the 
patient’s jaw or touching the patient, make sure electrically insulated gloves are used.

SEIZURE MONITORING

The Thymatron® System IV allows the physician to monitor the physiological 
variables of EEG, ECG, and EMG. The paper tracing provides the wave forms and 
beats per minute for the ECG. The EEG and EMG also appear on the tracings, with 
additional information provided.

EEG SEIZURE MONITORING

1) The Audible EEG1^ seizure monitor
2) The EEG paper recording
3) The Ictal Line™ seizure indicator
4) The EEG endpoint and indexes determined values

Audible EEG1^ Seizure Monitor

This feature operates automatically when the “TREAT” button is pressed and 
released. The knob marked “VOLUME” on the back panel controls the volume of 
the tone. To inactivate this feature, turn the volume control knob all the way 
counterclockwise.
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The pitch of the Audible EEG1^ signal varies with the amplitude of the EEG. It will 
waver and warble intensely and rapidly during the initial tonic phase. It becomes 
increasingly irregular, with superimposed staccato bursts, during the clonic phase, 
and tends to correspond to each muscular contraction. Seizure termination is 
marked by a change to a nearly steady tone with little modulation or variability. 
Each Thymatron® System IV is supplied with a cassette tape guide for the 
interpretation of the Audible EEG1^1 seizure monitor.

EEG paper recording

a) Paper EEG recording prior to the treatment stimulus can be initiated (after the 
EEG electrodes have been properly applied) by pressing the “START/STOP” 
button on the front panel. This will provide a paper record of the patient’s 
baseline recording. The printer stops during treatment stimulus administration.

b) Automatic paper EEG recording begins or resumes when the treatment stimulus 
ends. The EEG recording continues through ictal and postictal periods, until the 
“START/STOP” button is pressed, which generates the end-of-treatment report.

NOTE-. Obtaining a paper baseline EEG record does not replace the baseline EEG 
collection procedures described above.

Ictal Line™ Seizure Indicator

After baseline EEG collection is completed by the Thymatron® System IV and the 
“READY” message light appears, a thin black line is printed along the top of the 
paper recording strip when the EEG amplitude exceeds a specified baseline value. 
An unbroken, solid black line reflects continuous seizure activity. A broken or 
intermittent line reflects waxing and waning, or intermittent seizure activity. 
Complete cessation of the black line reflects EEG seizure termination, as 
determined by the Thymatron® System IV. Wait several seconds before pressing the 
“START/STOP” button to terminate recording because the computer takes that long to 
process and report the seizure endpoints and indices.

Endpoints and Indices

A unique feature of the Thymatron® System IV, (U.S. patents: 4873981, 4878498, 
5269302 and 5871517), provides two computer-determined estimates of the duration 
of the induced seizure, derived from the EEG and EMG data.

Automatic EEG Seizure Endpoint Determination

The Thymatron® System IV continuously monitors the EEG for the endpoint of 
seizure activity and prints the EEG seizure duration, in seconds, on the end-of- 
treatment report, provided the baseline EEG collection procedures have been properly 
followed and the “READY” message has appeared. (If the treatment stimulus is 
administered before the “READY” message appears, automatic EEG analysis will not 
occur and the end-of-treatment report will state the message “Baseline not available.")
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In about 10-20% of ECT treatments, the EEG endpoint is not readily determined 
(Abrams, 1997). This typically occurs when paroxysmal activity decreases too 
gradually to provide a clear visual endpoint, or when the immediate post-seizure 
EEG contains high amplitude activity. In these circumstances, inability to detect a 
precise EEG endpoint is expected with any method of examination. The Ictal Line™ 
might show an on-again-off-again broken line pattern, and the end-of-treatment 
report might state: “EEG Endpoint is not detected”.

Automatic EMG (Motor) Seizure Endpoint Determination

The Thymatron® System IV is shipped with the EMG monitor enabled in channel 
3. When EMG monitoring electrodes have been properly applied, the lead-wires and 
monitoring cable connected, then EMG tracing automatically appears on the paper 
record after the treatment stimulus ends.

The Thymatron® System IV continuously monitors the EMG for motor seizure 
activity and prints the EMG endpoint seizure duration in seconds, on the end-of- 
treatment report. Baseline EMG collection is neither required, nor possible, in 
obtaining this measure.

CAUTION: The computer-derived endpoint seizure duration measures, including the 
Ictal Line™ seizure indicator, are derived solely by calculation and are provided to aid, 
not replace, the physician’s judgment. It is possible for seizure activity to continue in 
the brain after any or all of the computer reports indicate seizure termination. It is also 
possible for artifact to be interpreted by the computer programs as seizure activity.

GAIN AND POSITION SETTINGS

The factory preset “GAIN” and “POSITION” settings should produce the best 
results. For those who prefer individualized settings, please note that “POSITION” 
is always set after “GAIN”, because positioning of the tracing on the recording 
paper depends on the amplitude, or gain of the signal. Thus, it is always necessary 
to set the “GAIN” in a specific channel before setting the “POSITION”.

FLEXDIAL™ • CHANN. [n] • G[n]-10 to G[n]-2000 • P[n]-AUTO, 
P[n]-0 to P[n]-800

G[n]-OFF Turns off printing in channel [n]
G[n]-10 to G[n]-2000 Adjusts channel [n] gain (in microvolts)

P[n]-AUTO Selects automatic positioning for printing channel [n]
P[n]-0 to P[n]-800 Adjusts position on strip from 0 (bottom) to 800 (top)

NOTE: The amplitudes of the tracings decrease as the gain numbers increase.
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TURN OFF PRINTING IN A CHANNEL

To turn off printing in a given channel, set the gain for that channel to “OFF”. If a 
given channel has been turned off, the other channels should be set to the “AUTO” 
position in order to evenly space the remaining tracings on the paper.

FLEXDIAL™ » CHANN. [n] » G[n]-OFF

CHANGING EEG GAIN RAPIDLY

TIP: To rapidly change the gain in all EEG channels, while the printer is running, 
press, hold in and then rotate the FIexDiaEM to print successive new gain values on the 
paper chart; release the FlexDiaE^ to lock in the desired value when it appears.

SEIZURE QUALITY MEASURES

The Thymatron® System IV provides 7 Seizure Quality Measures under the 
“INDEXES” function level that can be individually enabled/disabled. EEG 
monitoring must be enabled to obtain these measures. Their names and FlexDial™ 
designations are as follows:

Average Seizure Energy Index ASEI ON/OFF
Postictal Suppression Index PSI ON/OFF
Maximum Sustained Power and MSP ON/OFF

Time to Peak Power
Maximum Sustained Coherence and COH ON/OFF

Time to Peak Coherence
Duke University Amplitude Measures DUKE ON/OFF

The AVERAGE SEIZURE ENERGY INDEX (ASEI) integrates the total ictal EEG 
power across the entire seizure and divides the result by the total seizure duration.

The POSTICTAL SUPPRESSION INDEX (PSI) measures the percentage decrease 
in ictal EEG amplitude immediately following seizure termination.

The MAXIMUM SUSTAINED POWER (MSP) measure reports the mean value of 
the 10-second EEG segment with the highest average power recorded during the 
seizure.

TIME TO PEAK POWER is the time elapsed from stimulus termination to the 
point of maximum EEG power.

The MAXIMUM SUSTAINED COHERENCE (COH) measure reports the mean 
value of the 5-second EEG segment with the highest average coherence recorded 
during the seizure.
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TIME TO PEAK COHERENCE is the time elapsed from stimulus termination to 
the point of maximum EEG coherence.

DUKE UNIVERSITY AMPLITUDE MEASURES display the amplitudes of the 3 
seizure segments (early ictal, mid-ictal, and post-ictal) reported by Duke University 
investigators to correlate with ECT treatment response.

BASELINE RETENTION

Baseline Retention, BLV, found under ENDPOINTS, is the length of time the EEG 
baseline will be kept in memory after the treatment. It can be set from 0-5 minutes. 
After this time a new EEG baseline must be acquired. This feature is useful for re
stimulation without acquiring a new EEG baseline.

TO ENABLE/DISABLE SEIZURE QUALITY MEASURES

FLEXDIAL™ • INDEXES • AESI ON/OFF, PSI ON/OFF, MSP 
ON/OFF, COH ON/OFF, DUKE ON/OFF

In the “INDEXES” function level, repeatedly pressing the FlexDial will show a 
sequential flashing status display (ON/OFF) for ASEI, PSI, MSP, COH, and DUKE 
measures, in that order. Rotating the FlexDiaFM will flash-display the enable/disable 
(ON/OFF) options, for each index. Press the FlexDiaFM to select “ON” or “OFF” for 
each index and advance to the next. When the last index (DUKE) is 
enabled/disabled the display returns to INDEXES function level.

EEG FREQUENCY MEASURES

The Thymatron® System IV provides a continuously updated display of the user’s 
choice of one of 3 additional EEG measures: the 95% Spectral Edge Frequency (the 
EEG frequency below which 95% of the total EEG power is found), the Median 
Frequency (the EEG frequency above and below which 50% of power is found) and 
the Relative Delta Power (the % EEG power found in the delta bandwidth: 1.5-3.5 
Hz).

FLEXDIAL™ • EEG FREQ • SP. EDGE, MID FREQ, % DELTA

SP. EDGE 95% Spectral Edge Frequency
MID FREQ Median EEG frequency
% DELTA Relative EEG power in the delta bandwidth

When EEG FREQ is enabled with one of these options, baseline EEG collection has 
been obtained and the “READY” message appears, the values are continuously 
displayed in the 8-character L.E.D. After several seconds, the “READY” is replaced 
with the letter “R” to the right of the EEG values being displayed.
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PRINTER PAPER SPEED SELECTION

The Thymatron® System IV is shipped with the paper speed set to 25 mm/sec. 
Alternate paper speeds of 5 mm/sec and 50 mm/sec may be selected or the printing 
turned off entirely, as follows.

FLEXDIAL™ - PRINTOUT - PRINT 5, PRINT 25, PRINT 50 
TURN OFF PRINTING ENTIRELY

FLEXDIAL™ • PRINTOUT • PRINTOFF

POWER SPECTRAL ANALYSIS (FFT) SELECTION

After the paper speed has been selected by rotating and then pressing the 
FlexDial™, the FFT option (“ON” or “OFF”) flash-displays. FFT (“Fast Fourier 
Transform”) is an algorithm for extracting frequency information from the EEG 
signal to perform a Power Spectral Analysis that displays the EEG frequencies in 
various bandwidths for advanced clinical or research purposes. The Thymatron® 
System IV is shipped with the FFT printout disabled; to enable this feature:

FLEXDIAL™ • PRINTOUT • FFT ON, FFT OFF

USER SPECIFIED FLEXDIAL™ SELECTIONS

This feature allows the user to save and then recall up to 8 user-specified FlexDiaFM 
selections in the Thymatron® System IV memory. Individual doctors’ preferred 
range of FlexDiaFM settings can be saved as “USER” selections, or specific 
FlexDiaPM settings within a factory program can be saved, (e.g., turn channel 4 
“OFF” and “UPLOAD” automatically.) Once the different user-specified selections 
have been made and locked in by pressing the IMPEDANCE TEST button or the 
START/STOP button, they may be saved as a USER selection as follows:

FLEXDIAL™ • SAVEUSR • SAVE US 1-SAVE US8

After they have been saved, these user-specified selections can be recalled using the 
“SETTING” function of the FlexDial shell by selecting from the options “SET 
US1” through “SET US8”. Be sure to remember or write down which number this 
specific configuration was saved as, so it can easily be recalled.

FLEXDIAL™ 9 SETTING » SET US1 - SET US8

When a user-specified FlexDiaF^1 selection is in force, the “USER SET” dot L.E.D. 
on the front panel will light.
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RESET FLEXDIAL™ SETTINGS TO FACTORY VALUES

The factory-programmed values listed below for the 13 FlexDial™-se\ectab\e 
settings can be reset as a group as follows:

FLEXDIAL™ > SETTING -> RESET

Chann. 1............Gl-200 uV; Pl-AUTO
Chann. 2............G2-200 uV; P2-AUTO
Chann. 3............G3-1000 uV; P3-AUTO
Chann. 4............G4-1000 uV; P4-AUTO
FREQUENC...... Variable with LOW 0.5 program
P-WIDTH......... 0.5mS
PROGRAMS....LOW 0.5 program
CH. 3-4.............. EMG-ECG
ENDPOINT...... EEG-ON; EMG-ON; HR-ON; PHR-ON; ESA-OFF; BLV-2
INDEXES..........ASEI-ON; PSI-ON; MSP-ON; COH-ON; DUKE-OFF
EEG FREQ.......FREQ. OFF
PRINTOUT.......PRINT-25; FFT-OFF 
UPLOAD...........LOAD - OFF

TIP: To quickly reset all values to factory settings right after the “SELFTEST” has 
been performed at power-on, press the FlexDiaF^ three times in a row, then press 
the IMPEDANCE TEST button.

To print a report showing all the FlexDiaFM settings in effect at any given time, 
simply press the FlexDiaF^ to enter any function level and then press the 
START/STOP button.

TRANSFERRING DATA BETWEEN A PC AND THYMATRON® SYSTEM IV

The Thymatron® System IV allows the operator either to send data (upload) or to 
receive data (input or download) from a personal computer. The data transfers all 
require using GENIE™ IV software, which is included with the Thymatron® 
System IV. The data can be alphanumeric, such as the name of the hospital or 
patient information, or it can be digitized EEG, ECG, or EMG.

With the exception of the hospital’s name, all data to be downloaded must have been 
first uploaded to a PC using the GENIE™ IV software. One reason for downloading 
this data to the Thymatron® System IV would be to print a paper copy of an earlier 
treatment.

NOTE: All procedures listed below require the GENIE ™ IV software to be installed 
on a PC connected to the Thymatron® System IV through the rear panel RS 232 serial 
port and the GENIE™ IV software program opened to the proper section. Please 
consult the GENITAL IV manual for further details.
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INPUT HOSPITAL NAME FOR THE PRINTED REPORT

This name will replace the Thymatron® System IV, S/N line on the start-up report.

FLEXDIAL™ -> DATA IN -> DATA IN

i

1

|

1. Press the FlexDial to display the most recently adjusted FlexDiaP^ function.
2. Rotate the FlexDial1^ until “DATA IN” is displayed.
3. Press the FlexDiaFM once; “DATA IN” will flash-display.
4. Press the FlexDiaF^- again; “IN < < <" will flash-display.
5. On the PC, from the GENIE™ IV software main menu, click on CONNECT 9 

SEND NAME.
6. Type in hospital name in the “Name to Send” box and click “Send”.
7. Press the “IMPEDANCE TEST” or “START/STOP” button to exit the 

FlexDiaPM mode.

DOWNLOAD PRE-RECORDED TREATMENT DATA FROM PC FOR 
REPRINTING BY THYMATRON® SYSTEM IV

FLEXDIAL™ > DATA IN > DATA IN

This feature allows for previously recorded treatment data to be sent back to the 
Thymatron® System IV. Once the data has been received back in the Thymatron® 
System IV, it can then be reprinted using the “REPRINT” option in the “DATA 
OUT” function level.

1. Press the FlexDiaPM to display the most recently adjusted FlexDiaPM function.
2. Rotate the FlexDiaF^ until “DATA IN” is displayed.
3. Press the FlexDial^ once; “DATA IN” will flash-display.
4. Press the FlexDiaF^ again; "IN< < <" will flash-display.
5. On the PC, from the GENIE™ IV software main menu, click on FILE •> OPEN. 

Highlight the file to be sent and click OPEN. From the main menu, click on 
CONNECT 9 SEND DATA.

6. Transfer is complete when the display stops flashing and returns to “DATA IN”.
7. Press the “IMPEDANCE TEST” or “START/STOP” button to exit the 

FlexDiaFM mode.

This treatment data will now replace that of the last treatment given and will stay in 
the Thymatron® System IV memory until the unit is turned off or another 
treatment is given. To reprint this treatment on a paper record, see the DATA OUT 
section below.

UPLOAD TREATMENT DATA AUTOMATICALLY TO A PC

This feature allows for the automatic transfer of the treatment data to a PC after 
the printed end-of-treatment report. The PC must be connected to the Thymatron®
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System IV and the Genie™ IV software opened to the correct function; please 
review the GENIE™ IV manual for further details. The options are as follows:

LOAD OFF Disables UPLOAD function and no data will be transferred.
LOAD RAW Sends all EEG data, including the FFT points and end-of- 

treatment report.
LOAD FFT Sends all FFT points and end-of-treatment report.
LOAD TXT Sends ASCII file of the end-of-treatment report.

FLEXDIAL™ > UPLOAD > LOAD OFF, LOAD RAW, LOAD FFT, 
LOAD TXT

1. Press the FlexDial™ to display the most recently adjusted FlexDiaFM function.
2. Rotate the FlexDial until “UPLOAD” is displayed.
3. Press and rotate the FlexDiaFM to flash-display the above options.
4. Press the FlexDiaFM to select the desired option, usually “LOAD RAW”.
5. Press the “IMPEDANCE TEST” or “START/STOP” button to exit the 

FlexDiaF^ mode.

After the patient is treated and the end-of-treatment report is printed, the 
Thymatron® System IV is ready to send the data to the PC. Make sure all the 
connections are correct and the GENIE™ IV software is opened. From the 
GENIE™ IV main menu click on CONNECT 9 AUTO UPLOAD. A small screen 
will pop up showing the progress of the transfer. When the transfer is complete a 
new REPORT screen pops up with the treatment date and time.

Note: The transferred file will be automatically saved as the “date and time” of the 
treatment. This file can then be renamed and saved under the proper patient’s file by 
selecting from the GENIE™ IV main menu FILE -^ SAVE AS.

MONITOR EEG/EMG/ECG ON THE PC SCREEN

This feature allows for real-time monitoring of all enabled EEG/EMG/ECG 
channels via the PC screen, providing a constantly updated display of the actual 
EEG/EMG/ECG tracings before and after the treatment stimulus has been 
administered. This monitoring will not affect the printed paper recording.

Before starting to monitor, make sure all the connections are correct and the 
GENIE™ IV software is opened. From the GENIE™ IV main menu, click on 
WINDOW 9 GRAPH. From the main menu, click on TOOLS 9 PLAY 
CONTROL and then TOOLS 9 CHANNEL SETTING. Adjust the size of the 
graph screen to allow for these two pop up screens. To start the monitoring, follow 
the procedure below:

1. Press the IMPEDANCE TEST button to begin sending data.
2. Click on MONITOR in the PLAY CONTROL section.
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The monitoring will stop while the treatment stimulus is given with the “TREAT” 
button and it will automatically re-start after the stimulus is completed. The 
monitoring function will not interfere with the paper recording function as both will 
proceed at the same time. When the “START/STOP” button is pressed, the 
monitoring will also stop.

NOTE: To combine the monitoring and automatic upload  features, go to the GENIE™ 
IV main menu, click on CONNECT » AUTO UPLOAD. A small screen will pop up with 
the date & time for the name. Re-name the fde using the patient’s information, if desired and 
click UPLOAD. From the GENIE™ IVmain menu, click on WINDOWS 9 GRAPH and then 
TOOLS » PLA Y CONTROL and TOOLS » CHANNEL SETTING as above.

OUTPUT TREATMENT DATA MANUALLY

This feature allows for manual transfer of the treatment data after the end of a 
given treatment. The Thymatron® System IV stores only the last treatment in 
memory. If the unit is turned off or another treatment is given before data transfer, 
this data will be lost. This feature can be used when an occasional treatment is to be 
stored on the PC. Make sure all the connections are correct and the GENIE™ IV 
procedures are followed. Please review the GENIE™ IV manual. The options for 
“DATA OUT” are: *

REPRINT Reprints a complete record of the treatment just given, or can be used 
to reprint the treatment data just received from the PC. 

RAW DATA Sends all data including the FFT points and end-of-treatment report. 
FFT DATA Sends the FFT points and end-of-treatment report.
RESULTS Sends ASCII files of end-of-treatment report.
RETURN Returns to the DATA OUT function level of the FlexDial™.

FLEXDIAL™ • DATA OUT » REPRINT, RAW DATA, FFT DATA, 
RESULTS, RETURN

1. Press the FlexDiaFM to display the most recently adjusted FlexDial™ function.
2. Rotate the FlexDial until “DATA OUT” is displayed.
3. Press and rotate the FlexDiaP^ to flash-display the options listed above.
4. Press the FlexDiaFM to select the desired option, usually “RAW DATA”.
5. The message "OUT9 9> >" appears as the data is transferred to the computer.
6. If no treatment data is stored in memory the message “EMPTY” will flash and no 

data transfer will occur.
7. From the GENIE™ IV main menu, click on CONNECT 9 RECEIVE DATA. The 

small pop up screen will display the transfer progress. When finished, a new pop up 
screen, REPORT will contain the data. This file may be saved using the main menu 
FILE 9 SAVE AS feature.

8. When the transfer is complete, the FlexDiaF^ display returns to “DATA OUT”.
9. Press the “IMPEDANCE TEST” or “START/STOP” button to exit the 

FlexDiaF^ mode.
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REPRINT THE LAST TREATMENT

The Thymatron® System IV automatically stores the last treatment in memory. If 
the recording paper runs out or is damaged, the last treatment can be reprinted 
using this feature. This “REPRINT” feature also allows for the reprinting of the 
treatment data just transferred to the Thymatron® System IV from the PC. In 
either case, the only treatment reprinted will be the last one in the memory. If the 
unit is turned off, another treatment is transferred from the computer or another 
treatment is given, the earlier treatment data will be lost. The procedure for reprinting 
the treatment data is:

FLEXDIAL™ -> DATA OUT -> REPRINT

While the treatment data is being reprinted, the “REPRINT” message will flash 
until all the data has been reprinted, after which the printer will automatically stop, 
providing the original data contained an end-of-treatment report.

SET DATE & TIME IN PRINTED REPORT

To change/reset the time or date, use the following procedure. Enter the FlexDial 
mode, rotate to the “CLOCK” function level and then alternate pressing and rotating 
the FlexDial to make the following selections:

FLEXDIAL™-^ CLOCK —MONTH-) DAY-YEAR HOUR+MIN

MONTH 01 - 12

DAY 01 - 31

YEAR 00 - 99

HOUR 00 - 24

MIN 00 - 60
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TABLE 1: STANDARD DOSE STIMULUS PARAMETERS: STIMULUS 
DURATION (in seconds), CHARGE (in mC), AND JOULES (AT 220 OHMS 
IMPEDANCE) AT EVERY PERCENT ENERGY DIAL SETTING FOR ALL PW 
AND FREQUENCY COMBINATIONS

FREQ = 10 PW= .25
DIAL DURATION mC JOULES
5 % 5.60 25.2 5.0

FREQ = 20 PW= . 25
DIAL DURATION mC JOULES
5 % 2.80 25.2 5.0
10 % 5.60 50.4 10.0

FREQ = 30 PW= .25
DIAL DURATION mC JOULES
5 % 1.87 25.2 5.0
10 % 3.73 50.4 10.0
15 % 5.60 75.6 15.0
20 % 7.47 100.8 20.0

FREQ = 40 PW= .25
DIAL DURATION mC JOULES
5 % 1.40 25.2 5.0
10 % 2.80 50.4 10.0
15 % 4.20 75.6 15.0
20 % 5.60 100.8 20.0
25 % 7.00 126 24.9

FREQ = 50 PW= .25
DIAL DURATION mC JOULES
5 % 1.12 25.2 5.0
10 % 2.24 50.4 10.0
15 % 3.36 75.6 15.0
20 % 4.48 100.8 20.0
25 % 5.60 126 24.9
30 % 6.72 151.2 29.9
35 % 7.84 176.4 34.9

FREQ = 60 PW= .25
DIAL DURATION mC JOULES
5 % 0.93 25.2 5.0
10 % 1.87 50.4 10.0
15 % 2.80 75.6 15.0
20 % 3.73 100.8 20.0
25 % 4.67 126 24.9
30 % 5.60 151.2 29.9
35 % 6.53 176.4 34.9
40 % 7.47 201.6 39.9

FREQ = 70 PW= .25
DIAL DURATION mC JOULES
5 % 0.80 25.2 5.0
10 % 1.60 50.4 10.0
15 % 2.40 75.6 15.0
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20 % 3.20 100.8 20.0
25 % 4.00 126 24.9
30 % 4.80 151.2 29.9
35 % 5.60 176.4 34.9
40 % 6.40 201.6 39.9
45 % 7.20 226.8 44.9
50 %

FREQ = 10

8.00

PW= . 5

252 49.9

DIAL DURATION mC JOULES
5 % 2.80 25.2 5.0
10 %

FREQ = 20

5.60

PW= .5

50.4 10.0

DIAL DURATION mC JOULES
5 % 1.40 25.2 5.0
10 % 2.80 50.4 10.0
15 % 4.20 75.6 15.0
20 % 5.60 100.8 20.0
25 %

FREQ = 30

7.00

PW= . 5

126 24.9

DIAL DURATION mC JOULES
5 % 0.93 25.2 5.0
10 % 1.87 50.4 10.0
15 % 2.80 75.6 15.0
20 % 3.73 100.8 20.0
25 % 4.67 126 24.9
30 % 5.60 151.2 29.9
35 % 6.53 176.4 34.9
40 %

FREQ = 40

7.47

PW= . 5

201.6 39.9

DIAL DURATION mC JOULES
5 % 0.70 25.2 5.0
10 % 1.40 50.4 10.0
15 % 2.10 75.6 15.0
20 % 2.80 100.8 20.0
25 % 3.50 126 24.9
30 % 4.20 151.2 29.9
35 % 4.90 176.4 34.9
40 % 5.60 201.6 39.9
45 % 6.30 226.8 44.9
50 % 7.00 252 49.9
55 %

FREQ = 50

7.70

PW= . 5

277.2 54.9

DIAL DURATION mC JOULES
5 % 0.56 25.2 5.0
10 % 1.12 50.4 10.0
15 % 1.68 75.6 15.0
20 % 2.24 100.8 20.0
25 % 2.80 126 24.9
30 % 3.36 151.2 29.9
35 % 3.92 176.4 34.9
40 % 4.48 201.6 39.9
45 % 5.04 226.8 44.9
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50 %
55 %
60 %
65 %
70 %

5.60
6.16
6.72
7.28
7.84

252
277.2
302.4
327.6
352.8

49.9
54.9
59.9 
64.9 
69.9

FREQ = 60 PW= . 5
DIAL DURATION mC JOULES
5 % 0.47 25.2 5.0
10 % 0.93 50.4 10.0
15 % 1.40 75.6 15.0
20 % 1.87 100.8 20.0
25 % 2.33 126 24.9
30 % 2.80 151.2 29.9
35 % 3.27 176.4 34.9
40 % 3.73 201.6 39.9
45 % 4.20 226.8 44.9
50 % 4.67 252 49.9
55 % 5.13 277.2 54.9
60 % 5.60 302.4 59.9
65 % 6.07 327.6 64.9
70 % 6.53 352.8 69.9
75 % 7.00 378 74.8
80 % 7.47 403.2 79.8
85 % 7.93 428.4 84.8

FREQ = 70 PW= .5
DIAL DURATION mC JOULES
5 % 0.40 25.2 5.0
10 % 0.80 50.4 10.0
15 % 1.20 75.6 15.0
20 % 1.60 100.8 20.0
25 % 2.00 126 24.9
30 % 2.40 151.2 29.9
35 % 2.80 176.4 34.9
40 % 3.20 201.6 39.9
45 % 3.60 226.8 44.9
50 % 4.00 252 49.9
55 % 4.40 277.2 54.9
60 % 4.80 302.4 59.9
65 % 5.20 327.6 64.9
70 % 5.60 352.8 69.9
75 % 6.00 378 74.8
80 % 6.40 403.2 79.8
85 % 6.80 428.4 84.8
90 % 7.20 453.6 89.8
95 % 7.60 478.8 94.8
100 % 8.00 504 99.8

FREQ = 10 PW= .75
DIAL DURATION mC JOULES
5 % 1.87 25.2 5.0
10 % 3.73 50.4 10.0
15 % 5.60 75.6 15.0
20 % 7.47 100.8 20.0
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FREQ = 20 PW= .75
DIAL DURATION mC JOULES
5 % 0.93 25.2 5.0
10 % 1.87 50.4 10.0
15 % 2.80 75.6 15.0
20 % 3.73 100.8 20.0
25 % 4.67 126 24.9
30 % 5.60 151.2 29.9
35 % 6.53 176.4 34.9
40 % 7.47 201.6 39.9

FREQ = 30 PW= .75
DIAL DURATION mC JOULES
5 % 0.62 25.2 5.0
10 % 1.24 50.4 10.0
15 % 1.87 75.6 15.0
20 % 2.49 100.8 20.0
25 % 3.11 126 24.9
30 % 3.73 151.2 29.9
35 % 4.36 176.4 34.9
40 % 4.98 201.6 39.9
45 % 5.60 226.8 44.9
50 % 6.22 252 49.9
55 % 6.84 277.2 54.9
60 % 7.47 302.4 59.9

FREQ = 40 PW= . 75
DIAL DURATION mC JOULES
5 % 0.47 25.2 5.0
10 % 0.93 50.4 10.0
15 % 1.40 75.6 15.0
20 % 1.87 100.8 20.0
25 % 2.33 126 24.9
30 % 2.80 151.2 29.9
35 % 3.27 176.4 34.9
40 % 3.73 201.6 39.9
45 % 4.20 226.8 44.9
50 % 4.67 252 49.9
55 % 5.13 277.2 54.9
60 % 5.60 302.4 59.9
65 % 6.07 327.6 64.9
70 % 6.53 352.8 69.9
75 % 7.00 378 74.8
80 % 7.47 403.2 79.8
85 % 7.93 428.4 84.8

FREQ = 50 PW= .75
DIAL DURATION mC JOULES
5 % 0.37 25.2 5.0
10 % 0.75 50.4 10.0
15 % 1.12 75.6 15.0
20 % 1.49 100.8 20.0
25 % 1.87 126 24.9
30 % 2.24 151.2 29.9
35 % 2.61 176.4 34.9
40 % 2.99 201.6 39.9
45 % 3.36 226.8 44.9
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! 50 % 3.73 252 49.9
55 % 4.11 277.2 54.9
60 % 4.48 302.4 59.9
65 % 4.85 327.6 64.9
70 % 5.23 352.8 69.9
75 % 5.60 378 74.8
80 % 5.97 403.2 79.8
85 % 6.35 428.4 84.8
90 % 6.72 453.6 89.8
95 % 7.09 478.8 94.8
100 % 7.47 504 99.8

FREQ = 60 PW= . 75
DIAL DURATION mC JOULES
5 % 0.31 25.2 5.0
10 % 0.62 50.4 10.0
15 % 0.93 75.6 15.0
20 % 1.24 100.8 20.0
25 % 1.56 126 24.9
30 % 1.87 151.2 29.9
35 % 2.18 176.4 34.9| 40 % 2.49 201.6 39.9
45 % 2.80 226.8 44.9

1 50 % 3.11 252 49.9
55 % 3.42 277.2 54.9
60 % 3.73 302.4 59.9
65 % 4.04 327.6 64.9
70 % 4.36 352.8 69.9
75 % 4.67 378 74.8
80 % 4.98 403.2 79.8
85 % 5.29 428.4 84.8
90 % 5.60 453.6 89.8
95 % 5.91 478.8 94.8
100 % 6.22 504 99.8

FREQ = 70 PW= .75
DIAL DURATION mC JOULES
5 % 0.27 25.2 5.0
10 % 0.53 50.4 10.0
15 % 0.80 75.6 15.0
20 % 1.07 100.8 20.0
25 % 1.33 126 24.9
30 % 1.60 151.2 29.9
35 % 1.87 176.4 34.9
40 % 2.13 201.6 39.9
45 % 2.40 226.8 44.9
50 % 2.67 252 49.9
55 % 2.93 277.2 54.9
60 % 3.20 302.4 59.9
65 % 3.47 327.6 64.9
70 % 3.73 352.8 69.9
75 % 4.00 378 74.8
80 % 4.27 403.2 79.8
85 % 4.53 428.4 84.8
90 % 4.80 453.6 89.8
95 % 5.07 478.8 94.8
100 % 5.33 504 99.8
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FREQ = 10 PW= 1
DIAL DURATION mC JOULES
5 % 1.40 25.2 5.0
10 % 2.80 50.4 10.0
15 % 4.20 75.6 15.0
20 % 5.60 100.8 20.0
25 % 7.00 126 24.9

FREQ =
DIAL

20 PW= 1
DURATION mC JOULES

5 % 0.70 25.2 5.0
10 % 1.40 50.4 10.0
15 % 2.10 75.6 15.0
20 % 2.80 100.8 20.0
25 % 3.50 126 24.9
30 % 4.20 151.2 29.9
35 % 4.90 176.4 34.9
40 % 5.60 201.6 39.9
45 % 6.30 226.8 44.9
50 % 7.00 252 49.9
55 % 7.70 277.2 54.9

FREQ = 
DIAL

30 PW= 1
DURATION mC JOULES

5 % 0.47 25.2 5.0
10 % 0.93 50.4 10.0
15 % 1.40 75.6 15.0
20 % 1.87 100.8 20.0
25 % 2.33 126 24.9
30 % 2.80 151.2 29.9
35 % 3.27 176.4 34.9
40 % 3.73 201.6 39.9
45 % 4.20 226.8 44.9
50 % 4.67 252 49.9
55 % 5.13 277.2 54.9
60 % 5.60 302.4 59.9
65 % 6.07 327.6 64.9
70 % 6.53 352.8 69.9
75 % 7.00 378 74.8
80 % 7.47 403.2 79.8
85 % 7.93 428.4 84.8

FREQ = 
DIAL

40 PW= 1
DURATION mC JOULES

5 % 0.35 25.2 5.0
10 % 0.70 50.4 10.0
15 % 1.05 75.6 15.0
20 % 1.40 100.8 20.0
25 % 1.75 126 24.9
30 % 2.10 151.2 29.9
35 % 2.45 176.4 34.9
40 % 2.80 201.6 39.9
45 % 3.15 226.8 44.9
50 % 3.50 252 49.9
55 % 3.85 277.2 54.9
60 % 4.20 302.4 59.9

40

CHI000041
Pl. 140



J

65 %
70 %
75 %
80 %
85 %
90 %
95 %
100 %

4.55 
4.90
5.25 
5.60 
5.95
6.30
6.65 
7.00

327.6
352.8
378
403.2
428.4
453.6
478.8
504

64.9
69.9
74.8
79.8
84.8
89.8
94.8
99.8

1 ■ FREQ = 50 PW= 1
DIAL DURATION mC JOULES
5 % 0.28 25.2 5.0
10 % 0.56 50.4 10.0
15 % 0.84 75.6 15.0
20 % 1.12 100.8 20.0
25 % 1.40 126 24.9
30 % 1.68 151.2 29.9
35 % 1.96 176.4 34.9
40 % 2.24 201.6 39.9
45 % 2.52 226.8 44.9
50 % 2.80 252 49.9
55 % 3.08 277.2 54.9
60 % 3.36 302.4 59.9
65 % 3.64 327.6 64.9
70 % 3.92 352.8 69.9
75 % 4.20 378 74.8
80 % 4.48 403.2 79.8
85 % 4.76 428.4 84.8
90 % 5.04 453.6 89.8
95 % 5.32 478.8 94.8
100 % 5.60 504 99.8

FREQ = 60 PW= 1
DIAL DURATION mC JOULES
5 % 0.23 25.2 5.0
10 % 0.47 50.4 10.0
15 % 0.70 75.6 15.0
20 % 0.93 100.8 20.0
25 % 1.17 126 24.9
30 % 1.40 151.2 29.9
35 % 1.63 176.4 34.9
40 % 1.87 201.6 39.9
45 % 2.10 226.8 44.9
50 % . 2.33 252 49.9
55 % 2.57 277.2 54.9
60 % 2.80 302.4 59.9
65 % 3.03 327.6 64.9
70 % 3.27 352.8 69.9
75 % 3.50 378 74.8
80 % 3.73 403.2 79.8
85 % 3.97 428.4 84.8
90 % 4.20 453.6 89.8
95 % 4.43 478.8 94.8
100 % 4.67 504 99.8
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FREQ = 70 PW= 1
DIAL DURATION mC JOULES
5 % 0.20 25.2 5.0
10 % 0.40 50.4 10.0
15 % 0.60 75.6 15.0
20 % 0.80 100.8 20.0
25 % 1.00 126 24.9
30 % 1.20 151.2 29.9
35 % 1.40 176.4 34.9
40 % 1.60 201.6 39.9
45 % 1.80 226.8 44.9
50 % 2.00 252 49.9
55 % 2.20 277.2 54.9
60 % 2.40 302.4 59.9
65 % 2.60 327.6 64.9
70 % 2.80 352.8 69.9
75 % 3.00 378 74.8
80 % 3.20 403.2 79.8
85 % 3.40 428.4 84.8
90 % 3.60 453.6 89.8
95 % 3.80 478.8 94.8
100 % 4.00 504 99.8

FREQ — 10 PW= 1.25
DIAL DURATION mC JOULES
5 % 1.12 25.2 5.0
10 % 2.24 50.4 10.0
15 % 3.36 75.6 15.0
20 % 4.48 100.8 20.0
25 % 5.60 126 24.9
30 % 6.72 151.2 29.9
35 % 7.84 176.4 34.9

FREQ = 20 PW= 1.25
DIAL DURATION mC JOULES
5 % 0.56 25.2 5.0
10 % 1.12 50.4 10.0
15 % 1.68 75.6 15.0
20 % 2.24 100.8 20.0
25 % 2.80 126 24.9
30 % 3.36 151.2 29.9
35 % 3.92 176.4 34.9
40 % 4.48 201.6 39.9
45 % 5.04 226.8 44.9
50 % 5.60 252 49.9
55 % 6.16 277.2 54.9
60 % 6.72 302.4 59.9
65 % 7.28 327.6 64.9
70 % 7.84 352.8 69.9

FREQ = 30 PW= 1.25
DIAL DURATION mC JOULES
5 % 0.37 25.2 5.0
10 % 0.75 50.4 10.0
15 % 1.12 75.6 15.0
20 % 1.49 100.8 20.0
25 % 1.87 126 24.9
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30 % 2.24 151.2 29.9
35 % 2.61 176.4 34.9
40 % 2.99 201.6 39.9
45 % 3.36 226.8 44.9
50 % 3.73 252 49.9
55 % 4.11 277.2 54.9
60 % 4.48 302.4 59.9
65 % 4.85 327.6 64.9
70 % 5.23 352.8 69.9
75 % 5.60 378 74.8
80 % 5.97 403.2 79.8

- 85 % 6.35 428.4 84.8
90 % 6.72 453.6 89.8
95 % 7.09 478.8 94.8
100 % 7.47 504 99.8

FREQ = 40 PW= 1.25
DIAL DURATION mC JOULES
5 % 0.28 25.2 5.0
10 % 0.56 50.4 10.0
15 % 0.84 75.6 15.0
20 % 1.12 100.8 20.0
25 % 1.40 126 24.9
30 % 1.68 151.2 29.9
35 % 1.96 176.4 34.9
40 % 2.24 201.6 39.9
45 % 2.52 226.8 44.9
50 % 2.80 252 49.9
55 % 3.08 277.2 54.9
60 % 3.36 302.4 59.9
65 % 3.64 327.6 64.9
70 % 3.92 352.8 69.9
75 % 4.20 378 74.8
80 % 4.48 403.2 79.8
85 % 4.76 428.4 84.8
90 % 5.04 453.6 89.8
95 % 5.32 478.8 94.8
100 % 5.60 504 99.8

FREQ = 50 PW= 1.25
DIAL DURATION mC JOULES

1 5 % 0.22 25.2 5.0
10 % 0.45 50.4 10.0
15 % 0.67 75.6 15.0
20 % 0.90 100.8 20.0
25 % 1.12 126 24.9
30 % 1.34 151.2 29.9
35 % 1.57 176.4 34.9
40 % 1.79 201.6 39.9
45 % 2.02 226.8 44.9
50 % 2.24 252 49.9
55 % 2.46 277.2 54.9
60 % 2.69 302.4 59.9
65 % 2.91 327.6 64.9
70 % 3.14 352.8 69.9
75 % 3.36 378 74.8
80 % 3.58 403.2 79.8
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85 % 3.81 428.4 84.8
90 % 4.03 453.6 89.8
95 % 4.26 478.8 94.8
100 % 4.48 504 99.8

FREQ = 60 PW= 1.25
DIAL DURATION mC JOULES
5 % 0.19 25.2 5.0
10 % 0.37 50.4 10.0
15 % 0.56 75.6 15.0
20 % 0.75 100.8 20.0
25 % 0.93 126 24.9
30 % 1.12 151.2 29.9
35 % 1.31 176.4 34.9
40 % 1.49 201.6 39.9
45 % 1.68 226.8 44.9
50 % 1.87 252 49.9
55 % 2.05 277.2 54.9
60 % 2.24 302.4 59.9
65 % 2.43 327.6 64.9
70 % 2.61 352.8 69.9
75 % 2.80 378 74.8
80 % 2.99 403.2 79.8
85 % 3.17 428.4 84.8
90 % 3.36 453.6 89.8
95 % 3.55 478.8 94.8
100 % 3.73 504 99.8

FREQ = 70 PW= 1.25
DIAL DURATION mC JOULES
5 % 0.16 25.2 5.0
10 % 0.32 50.4 10.0
15 % 0.48 75.6 15.0
20 % 0.64 100.8 20.0
25 % 0.80 126 24.9
30 % 0.96 151.2 29.9
35 % 1.12 176.4 34.9
40 % 1.28 201.6 39.9
45 % 1.44 226.8 44.9
50 % 1.60 252 49.9
55 % 1.76 277.2 54.9
60 % 1.92 302.4 59.9
65 % 2.08 327.6 64.9
70 % 2.24 352.8 69.9
75 % 2.40 378 74.8
80 % 2.56 403.2 79.8
85 % 2.72 428.4 84.8
90 % 2.88 453.6 89.8
95 % 3.04 478.8 94.8
100 % 3.20 504 99.8

FREQ = 10 PW= 1.5
DIAL DURATION mC JOULES
5 % 0.93 25.2 5.0
10 % 1.87 50.4 10.0
15 % 2.80 75.6 15.0
20 % 3.73 100.8 20.0
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25 %
30 %
35 %
40 %

4.67 126 24.9
5.60 151.2 29.9
6.53 176.4 34.9
7.47 201.6 39.9

FREQ = 
DIAL 
5 % 
10 % 
15 % 
20 % 
25 % 
30 % 
35 % 
40 % 
45 % 
50 % 
55 % 
60 % 
65 % 
70 % 
75 % 
80 % 
85 %

20 PW= 1.5
DURATION mC JOULES
0.47 25.2 5.0
0.93 50.4 10.0
1.40 75.6 15.0
1.87 100.8 20.0
2.33 126 24.9
2.80 151.2 29.9
3.27 176.4 34.9
3.73 201.6 39.9
4.20 226.8 44.9
4.67 252 49.9
5.13 277.2 54.9
5.60 302.4 59.9
6.07 327.6 64.9
6.53 352.8 69.9
7.00 378 74.8
7.47 403.2 79.8
7.93 428.4 84.8

FREQ = 
DIAL 
5 % 
10 % 
15 % 
20 % 
25 % 
30 % 
35 % 
40 % 
45 % 
50 % 
55 % 
60 % 
65 % 
70 % 
75 % 
80 % 
85 % 
90 % 
95 % 
100 %

30 PW= 1.5
DURATION mC JOULES
0.31 25.2 5.0
0.62 50.4 10.0
0.93 75.6 15.0
1.24 100.8 20.0
1.56 126 24.9
1.87 151.2 29.9
2.18 176.4 34.9
2.49 201.6 39.9
2.80 226.8 44.9
3.11 252 49.9
3.42 277.2 54.9
3.73 302.4 59.9
4.04 327.6 64.9
4.36 352.8 69.9
4.67 378 74.8
4.98 403.2 79.8
5.29 428.4 84.8
5.60 453.6 89.8
5.91 478.8 94.8
6.22 504 99.8

FREQ =
DIAL 
5 % 
10 % 
15 % 
20 % 
25 % 
30 % 
35 %

40 PW= 1.5
DURATION mC JOULES
0.23 25.2 5.0
0.47 50.4 10.0
0.70 75.6 15.0
0.93 100.8 20.0
1.17 126 24.9
1.40 151.2 29.9
1.63 176.4 34.9
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40 % 1.87 201.6 39.9
45 % 2.10 226.8 44.9
50 % 2.33 252 49.9
55 % 2.57 277.2 54.9
60 % 2.80 302.4 59.9
65 % 3.03 327.6 64.9
70 % 3.27 352.8 69.9
75 % 3.50 378 74.8
80 % 3.73 403.2 79.8
85 % 3.97 428.4 84.8
90 % 4.20 453.6 89.8
95 % 4.43 478.8 94.8
100 % 4.67 504 99.8

FREQ = 50 PW= 1.5
DIAL DURATION mC JOULES
5 % 0.19 25.2 5.0
10 % 0.37 50.4 10.0
15 % 0.56 75.6 15.0
20 % 0.75 100.8 20.0
25 % 0.93 126 24.9
30 % 1.12 151.2 29.9
35 % 1.31 176.4 34.9
40 % 1.49 201.6 39.9
45 % 1.68 226.8 44.9
50 % 1.87 252 49.9
55 % 2.05 277.2 54.9
60 % 2.24 302.4 59.9
65 % 2.43 327,6 64.9
70 % 2.61 352.8 69.9
75 % 2.80 378 74.8
80 % 2.99 403.2 79.8
85 % 3.17 428.4 84.8
90 % 3.36 453.6 89.8
95 % 3.55 478.8 94.8
100 % 3.73 504 99.8

FREQ = 60 PW= 1.5
DIAL DURATION mC JOULES
5 % 0.16 25.2 5.0
10 % 0.31 50.4 10.0
15 % 0.47 75.6 15.0
20 % 0.62 100.8 20.0
25 % 0.78 126 24.9
30 % 0.93 151.2 29.9
35 % 1.09 176.4 34.9
40 % 1.24 201.6 39.9
45 % 1.40 226.8 44.9
50 % 1.56 252 49.9
55 % 1.71 277.2 54.9
60 % 1.87 302.4 59.9
65 % 2.02 327.6 64.9
70 % 2.18 352.8 69.9
75 % 2.33 378 74.8
80 % 2.49 403.2 79.8
85 % 2.64 428.4 84.8
90 % 2.80 453.6 89.8
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95 %
100 %

2.96
3.11

478.8
504

94.8
99.8

FREQ = 70 PW= 1.5
DIAL DURATION mC JOULES

5 % 0.13 25.2 5.0
10 % 0.27 50.4 10.0
15 % 0.40 75.6 15.0
20 % 0.53 100.8 20.0
25 % 0.67 126 24.9
30 % 0.80 151.2 29.9
35 % 0.93 176.4 34.9
40 % 1.07 201.6 39.9
45 % 1.20 226.8 44.9
50 % 1.33 252 49.9
55 % 1.47 277.2 54.9
60 % 1.60 302.4 59.9
65 % 1.73 327.6 64.9
70 % 1.87 352.8 69.9

75 % 2.00 378 74.8
80 % 2.13 403.2 79.8
85 % 2.27 428.4 84.8
90 % 2.40 453.6 89.8
95 % 2.53 478.8 94.8
100 % 2.67 504 99.8
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TABLE 2: DOUBLE DOSE PARAMETERS: Frequency (in Hertz), Pulsewidth (in 
milliseconds) and Stimulus Duration (in seconds), for each Energy Dial Setting 
above 100%. *(Not available in USA or Canada)

The 2X Dose and 2X LP programs provide the only method for exceeding the 100% 
Energy maximum of the Thymatron® System IV. When selected, eithei program 
automatically chooses the requisite frequency and pulsewidth, which are then NOT 
user-selectable. It is not possible to further set either frequency or pulsewidth 
because the Thymatron® System IV will not go past 100% Energy with manual 
(FlexDial) selection of these variables.

2X Dose _________ 2X Dose Lowest Pulsewidth
%
Energy

Freq. 
Hz

Pulse
Width

Duration 
Sec.

Freq. 
Hz

Pulse 
width

Duration 
Sec.

5 10 Hz 0.5 ms 2.75 sec 10 Hz 0.25 ms 5.55 sec

10 10 0.5 5.55 20 0.25 5.58
15 20 0.5 4.18 30 0.25 . 5.58
20 20 0.5 5.58 30 0.25 _ 7.45

25 30 0.5 4.65 40 0.25 6.99
30 30 0.5 5.58 50 0.25 6.71
35 30 0.5 6.52 50 0.25 7.83

40 30 0.5 7.45 60 0.25 7.46
45 40 0.5 6.29 70 0.25 7.19
50 40 0.5 6.99 70 _ 0.25 7.99
55 50 0.5 6.15 80 0.25 7.69
60 50 0.5 6.71 90 0.25 7.46
65 50 0.5 7.27 100 0.25 7.28
70 50 0.5 7.83 100 0.25 7.84
75 60 0.5 6.99 110 0.25 7.63

80 60 0.5 7.46 120 0.25 7.46
85 70 0.5 6.79 120 0.25 7.93
90 70 0.5 7.19 130 0.25 7.75
95 70 0.5 7.59 140 0.25 7.60
100 70 0.5 7.99 140 0.25 8.00
110 60 0.75 6.83 100 0.4 7.70
120 60 0.75 7.46 110 0.4 7.63
130 70 0.75 6.83 120 0.4 7.58
140 70 0.75 7.46 100 0.5 7.84
150 70 0.75 7.99 110 0.5 7.63
160 60 1.0 7.46 120 0.5 7.46
170 60 1.0 7.93 120 0.5 7.93
180 70 1.0 7.19 110 0.6 7.63
190 70 1.0 7.59 120 0.6 7.38
200 70 1.0 7.99 100 0.7 8.00
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1

EMC SUPPLEMENT

1. An externally generated artifact is indicated if all the channels exhibit the same 
pattern superimposed on or interfering with the signal. Try repositioning the 
electrode leads to eliminate this pattern.

2. A power mains artifact is indicated if all channels exhibit a thick solid line. Try 
repositioning the electrode leads to eliminate this.

3. A large static discharge may cause the system to reset. The system would go 
through the “SELFTEST” again and be ready to treat in about five seconds. To 
minimize static electricity make sure to maintain sufficient humidity in the 
treatment room and have a good grounding system on your mains.

4. A large high frequency pulse (e.g., as from electromagnetic imaging equipment) 
may cause the system to reset. The system would go through the “SELFTEST ’ 
again and be ready to treat in about five seconds. If this occurs make sure to 
identify the device(s) producing these pulses and maintain sufficient distance 
between the Thymatron® System IV and the device(s) to prevent reoccurrence; if 
this is not possible, shielding may be required.
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EMC DECLARATION

Guidance and manufacturer’s declaration - electromagnetic emissions_________

Thymatron® ECT Systems are intended for use in the electromagnetic environment specified below. The 
customer or the user of a Thymatron® System should assure that it is used in such an environment.-----------------

Emissions Test Compliance Electromagnetic Environment - 
__________ Guidance___________

RF emissions
CISPR11 Group 1

Thymatron® Systems use RF energy 
only for internal functions.
Therefore, RF emissions are very 
low and are not likely to cause any 
interference in nearby electronic 
equipment. ___________

RF emissions
CISPR 11

Class A Thymatron® Systems are suitable 
for use in all establishments other 
than domestic and those directly 
connected to the public low-voltage 
power supply network that supplies 
buildings used for 
domestic purposes.

Harmonic emissions, 
IEC 61000-3-2

Class A

Voltage fluctuations/ 
flicker emissions 
IEC 61000-3-3

Complies
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EC DECLARATION OF CONFORMITY 
To the Medical Device Directive 93/42/EEC

SOMATICS, LLC. 
910 Sherwood Drive 

Lake Bluff IL 60044, USA

Represented in EEC by Fred Berninger Importe OHG, Bergstrasse 12, 
82024 Taufkirchen, Germany

Declares that the distributed CE marked products conform to the types covered by the

EC Certificate Number 86253CE01 
issued by DEKRA, in accordance with Annex II of the 

Medical Directive 93/42/EEC

In addition, we ensure and declare that the distributed CE marked products, 
as mentioned and falling within Class lib meet the provisions of 

the EC-Directive which apply to them.

This declaration is based on the application of the Quality System approved 
for the manufacture and final inspection of the products concerned, in 
accordance with Annex II of the EC-Directive. The conformity of the 

production quality assurance set out in Annex II.

This declaration is supported by the Quality System certification based on the 
harmonized standardsTSO 13485:2003

Quality System Certificate No. 160440.01

This Declaration of Conformity covers Thymatron Electroconvulsive Therapy Devices and 
is valid for all products distributed by Somatics, LLC. bearing the CE mark, including the 

Thymatron® System IV, starting with serial No. 40020 and Thymatron System® II, 
starting with serial No. 40236 and ending with serial No. 41950
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ADDENDUM I

SOFTWARE UPGRADES TO THYMATRON® SYSTEM IV

NB: The software version of your Thymatron® System IV is automatically 
printed at power-up.

Each of the following Thymatron® System IV and GENIE™ IV software upgrades 
includes all previous upgrades.

SOFTWARE REQUIRES
VERSION DATE DESCRIPTION GENIE VERSION

4.31 6/1/99 The initial software 4.5

4.32 6/15/99 DOS-compatible 4.5

5.00 9/1/00 Real time PC monitoring 
Palm® connection.

5.0

5.10 5/1/01 Diagnostic messages for EEG endpoint. 5.0

5.20 8/1/01 LOW 0.25 program 5.0

5.30 5/1/02 Automatic upload to PC
SEI upgraded to ASEI, SGI retired 
Impedance test increased to 800 Hz.

6.3

5.40 11/15/02 EEG Frequency Measures 6.3

5.41 2/1/03 Eliminates recalibration after chip upgrade. 6.3

5.50 7/1/04 Improved algorithm for PSI
Change program via Percent Energy Dial
Change EEG gain while recording 
2X Dose, (where available) changes by 5% 
increments, up to 100%, then by 10% to 200%

6.3

5.60 6/15/09 Adjust baseline retention (BLV), 0-5 minutes 
Reset EEG Baseline when pushing Impedance 
Test & Energy Buttons simultaneously 
Allows for 0.25 or 0.3 & 2X-LP Program

6.3

5.61 12/1/09 USER programs display up to 70 Hz 6.3

5.62 09/07/10 Reset “USER” mode to last frequency 6.3

5.63 11/03/10 Changes Baseline Validity settings 6.3
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ADDENDUM II
ELECTRODE PLACEMENTS
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4 channel setup--2 EEG, 1 EMG, 1 ECG channel *
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( 3 channel setup..... 1 EEG, 1 EMG, 1 ECG channel

Electrode connections for channel 1 EEG, channel 3 EMG, channel 4 ECG recording
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1. Introduction

The Genie IV program allows you to collect, analyze, and display EEG, EMG, and ECG data from 
the Thymatron System IV in real-time. It also has functions to save and playback treatment sessions, 
and edit the patient information associated with a set of data. If desired, Genie IV can automatically 
collect the data of multiple treatment sessions, eliminating the need for any operator intervention in 
between patients.

J

2. Installation
|

2.1. Program Files

Genie IV woks with MS Windows 95/98/ME/2K/XP. If you don’t already have a floppy disk 
containing the Genie IV software, you can download it from

http://thymatron.com/sub_downloads.asp

The program is self-contained, and does not require you to run an installer. Just create a folder on 
your computer called “Genie” and drag the Genie [xXX] .exe1 and Sample.dat files from your 
floppy or download into that folder. Any data files you save will be kept in that directory, as well as a 
Genie. cf g file that stores your settings when you quit the program. To run Genie IV, double-click 
the Genie [ xxx ] file.

1 The [xxx] represents the version number of the particular Genie your are using; for instance, Genie641 .exe. 
Also, depending on how your Windows installation is configured, the .exe extension may be hidden.

2.2. Connecting the Serial Cable

The Genie IV software communicates with the Thymatron System IV using a 9-pin serial cable. 
Connect one end to the serial port, labeled RS232, on the rear panel of the Thymatron, and the other 
end to a 9-pin port on your computer. If your computer does not have a built-in serial port, you can 
use a USB-to-Serial converter: we have tested the Genie with Keyspan’s USA-19QW and USA- 
19HS adapters; these can also be purchased through Somatics, if you wish.

You will need to know the “COM Number” of your serial port, the first time you run Genie. Though 
this number varies from computer to computer, there are some guidelines that might help you:

I : *
• If you have a built-in serial port, try COME
■ If you are using a USB-to-Serial converter, and also have a modem on your computer, try 

C0M5.
• If you are using a USB-to-Serial converter, but do not have a modem, try COMI or COM2.
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• You can also find the COM ports available on your computer by using the Device Manager 
function of Windows

To set the COM port, open the Connect menu once you have run the program, and choose the Set 
Port item to display a list of COM ports from which you can select one. Note that if you select an 
invalid COM port, the Genie software will give you a warning, and you can try another. There is no 
harm in trying different COM ports until you find the correct one.

|
3. User Interface
The first time you run Genie IV, it will attempt to detect your COM port, and then you will see a gray 
screen with a menu bar at the top. The menus are:

File Used to load and save data to disk, print, and exit the program.

Connect For sending to and receiving data from the Thymatron.

Patientinfo Allows you to set patient information, such as the name, age, and sex, stored with the 
data.

Tools This menu is available only when a window is open. It contains commands for 
recording and playing back data.

Window Used to open various types of windows (Graph, FFT, etc.) for viewing the collected 
data, and for selecting among the windows you have open. These are discussed 
individually in section 5 on page 4.

About Shows the version number of the Genie IV.

In the Tools menu there are two items, Play Control and Channel Settings, that open floating “control 
panels” that allow you to more easily activate recording and playback functions. These controls are 
discussed in section 8 on page 6.

4. Collecting Data

To monitor in real-time the channels of the Thymatron,

1. Run the Genie program as described above
2. Open the Window menu and select the Graph item. A four-channel graph screen will appear, as 

well as the Control and Setting floating panels.
3. Acquire an impedance reading by holding the Impedance button on the Thymatron until a 

value is shown on the LED display. Note that the patient does not have to be hooked up to the 
stimulus electrodes—you can continue monitoring with a 30009 reading.

4. On the Control panel, click the Monitor button. The Genie will begin to display data, 
organized into 1.28 second epochs, or segments.

5. When you wish to stop monitoring, click on the Stop Mon button in the Control panel.

2
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j

To upload the collected data from the Thymatron to Genie,

1. Press the FlexDial™ on the Thymatron, and rotate the dial until “DATA OUT” is displayed on 
the 8-character LED.

2. Press the FlexDial, and then rotate it until “RAW DATA” is shown.
3. In the Genie program, open the Connect menu and click Receive Data.
4. Press the FlexDial to begin the data upload process.
5. When the transfer finishes, press the Start/Stop button on the Thymatron to exit the FlexDial 

menu.
6. If you wish, you can use the Patientinfo menu to store information such as the name, sex, age, 

etc. of the patient before saving the data.

See section 8 on page 6 for detailed information on how to review the collected data, alter the 
playback speed and channel gain, and mark any artifacts found; and see section 6 on page 4 for 
instructions on saving and loading data to files on your computer.

4.1. Auto Upload

Auto Upload is the feature that provides for operator-free data collection from multiple patients. To 
use it,

1. From the Connect menu, select Auto Upload.
2. Your files will be named according to the date, time, and a sequence number. You can choose 

the directory in which you want to store the files.
3. When you have chosen the directory, click Upload.

At this point, the Genie IV is ready: it will begin collecting data when treatment is initiated, and will 
end when the Start/Stop button on the Thymatron is pressed after treatment. It then saves the data to 
a file, and is ready for the next patient.

4.2. Automatic Operation

Using the monitoring and automatic upload features together provides a convenient method of 
operating the Genie TV when treating several patients in a row. To set up the software,

1. Turn on Auto Upload as described in section 4.1.
2. Begin monitoring the patient according to the directions in section 4.
3. The graph screen will show real-time traces of selected channels.
4. While the stimulus is being delivered, the graph will pause.
5. After the Start/Stop button on the printer is pressed, Genie will automatically upload data from 

the Thymatron, save it, and then wait for the next patient to be treated.
6. When the impedance has been acquired on the next patient, the Genie will automatically begin 

monitoring again.
If you would like to perform post-treatment monitoring on a patient, obtain another 

impedance reading and the Genie will resume monitoring.

3
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At the end of the day, you will have a number of files saved by Genie in a folder on your computer. It 
is often a good idea to go through these files and rename them to more descriptive names; also, you 
can open the saved data files in Genie and use the Patientinfo menu to enter more detailed 
characteristics (name, age, etc.).

5. Analysis Screens
In addition to the Graph window, you can view real-time analyses of the data in the FFT, Bands, and 
Spectrum windows; and a summary of the treatment, similar to the one printed out by the 
Thymatron, in the Report window. To open any of these displays, use the Window menu. When you 
are looking at the FFT, Bands, or Spectrum display, an additional Spectrum menu will be available. It 
allows you to choose between an analysis of the accumulated spectrum data thus far (Accumulated 
Spectrum), or just the current segment (Current Segment). Depending on the type of window you 
have open, the Spectrum menu may have additionally functions, as described below.

Graph The Graph window displays traces from EEG channels 1 & 2, and up to two more 
' EEG channels, or EMG and ECG channels. See section 8 on page 8 for instructions 

on how to configure the graph display.
FFT The FFT window shows a 32-bar display of the FFT analysis of EEG channels 1 & 2.

Bands The Bands window displays the numeric values of the absolute EEG power, relative 
EEG power, % interhemispheric coherence, and % interhemispheric asymmetry, for 
each of the four standard frequency bands (delta, theta, alpha, beta) plus 2 additional 
user-assignable bandwidths. These variables are used to assess the relative inter
hemispheric symmetiy in EEG amplitude and phase.

When you are collecting in four-channel mode, you can use the Spectrum menu 
to select any pair of EEG channels to analyze. Also the Spectrum menu will contain a 
Set Bands item that lets you choose the range (in Hz) for each of the frequency 
bands.

Any number of separate Bands windows may be opened simultaneously by using 
the Window menu and selecting the Bands item.

Spectrum The Spectrum displays numeric values for absolute power, relative power, 
asymmetry, and coherence, for each of 32 frequency points, in steps of 0.78 Hz.

When you are collecting in four-channel EEG mode, you can use the Spectrum 
menu to select any pair of EEG channels to analyze.

Any number of separate Spectrum windows may be opened simultaneously by 
using the Window menu and selecting the Spectrum item.

6. Loading and Saving Data to Disk

The File menu has items that relate to loading and saving data to your computer.
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Menu Item Function

New Clears any data you have collected so far, and readies the Genie IV to accept 
new data.

Open 
Save

Allows you to choose a file from which to load saved data.

Writes your current data to disk.

Save As Allows you to choose a file name under which to save.
Save As Text Exports data as text (see the next section).
Print Lets you choose among the various windows, and sends your selection to a 

printer.
Exit Closes the software.

6. 1. Exporting as Text

Normally, Genie IV saves data in a binary format in files with a .DAT or .EDT extension, which are 
readable only by the Genie software. It may be useful to export the raw data, analysis windows, or 
summary report as a text file, so that it can be read by other software, for instance MS Excel.

To export a specific window as a text file2,

1. Open the appropriate display (Graph, FFT, etc.) using the Window menu.
2. Choose Save As Text... from the File menu.
3. You will be asked if you would like to include the patient information with the text output, and 

also for a file name.
If you want to import this text file into Excel

1. Choose Open from Excel’s file menu, select the appropriate file name, and then use Excel’s 
data import wizard to continue the process.

2. On the first page, choose the “Delimited” data type.
3. On the next page, ensure that only “Comma” is selected as the delimiter—by default Tab will 

be selected, so uncheck it
4. On the third page you may accept the default of “General” column types.

7. Sending and Receiving Data from the Thymatron

In the Connect menu are a number of functions related to transferring data between the computer and 
the Thymatron.

2 Specifically, these will be in Comma-Separated Value (CSV) format, which is a standard for text files that 
is interoperable among many programs.

Menu Item Function

Send Data Transmits data from Genie to the Thymatron (see below).
Receive Data Uploads data from the Thymatron to Genie, as described above.

5
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Send Name 
Auto Upload 
Set Port

Sets the name printed on the Thymatron summary report.
Toggles auto-upload mode, as described above.
Specifies to which COM port the Thymatron is connected.

To use the Send Data and Send Name functions, you must prepare the Thymatron to receive data:

1. Press the FlexDial on the Thymatron, and rotate the dial until “DATA IN” is displayed on the 
8-character LED.

2. Press the FlexDial; DATA IN will flash on the display.
3. Press the FlexDial again to make the Thymatron ready to receive data.
4. In the Genie program, open the Connect menu and click Send Data or Send Name.
5. When the transfer finishes, press the Start/Stop button on the Thymatron to exit the FlexDial 

menu.
To use the Receive Data function, follow the steps given previously in the discussion of Collecting 
Data. .

8. Monitoring and Playback Controls

8.1. Control Panel

Once you have uploaded data from the Thymatron or loaded a file from disk, you can playback that 
data at a variety of speeds and mark any segments that contain artifacts.

On the Control panel, available from the Tools menu, you can select a subset of the data to review 
and change the speed at which it is played back. To view only a specific time range, type in the 
desired value into the Time Set field. From the Speed drop-down box, you can choose the playback 
speed from 25%—500% of real time.

There are also certain controls available while you are playing back data:

PlayBack/S topBack Starts and stops playback, respectively.

Monitor/StopMon Begins and ends monitoring of the Thymatron, respectively.
Reset

Reject
Jumps to the beginning of the collected data.

Marks the segment currently being viewed as an artifact, so that it won’t 
factor in to the statistical analyses performed on the data set.

8.2. Settings Panel

From the Settings panel, available through the Tools menu, you can customize the behavior and 
display of the input channels. To enable a channel, ensure that there is a checkmark next to its On 
label. For channels 3 & 4, you can select among EEG, EMG, and ECG inputs. The Scale dropdown 
box lets you change the display scale of each channel, in uV . The Artifact field contains a value in
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V above which a segment will be automatically flagged as an artifact.

8.3. Keyboard Shortcuts

Most common operations have equivalent keyboard shortcuts, which can make using the Genie 
software much more efficient; a table of these shortcuts is given.

Function Shortcut

New Ctrl+N

Open Ctrl+O

Save Ctrl+S

Print Ctrl+P

Send Data Ctrl+F2

Receive Data Ctrl+F3

Auto Upload Ctrl+U

PlayBack/Stop Playback Ctrl+B

Monitor/Stop Monitoring Ctrl+T

Reset Ctrl+R

Reject Ctrl+J
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